Pro Tools | Dock Guide
and EuControl 19.5
# Contents

## Introduction ................................. 1
- What’s Included .................................. 2
- Additional Required Equipment ............... 2
- Optional Equipment ............................... 2
- System Requirements and Compatibility ..... 2
- Registration ..................................... 2
- About This Guide .................................. 2
- Conventions Used in This Guide ............. 3
- Hardware Switches on the Dock and S3 Control Surface .......................... 3
- How to Use this PDF Guide .................... 4
- Resources ......................................... 4

## Installation and Setup .......................... 5
- Connecting the Dock .............................. 5
- Installing EuControl Software .................. 7
- Updating Dock Firmware .......................... 9
- Installing and Connecting Pro Tools | Control ........................................... 10
- Enabling EUCON in Pro Tools .................... 11
- Confirming EUCON ................................ 12
- Connecting a Second Workstation ............ 13
- Connecting a Footswitch ......................... 14
- Kensington Lock .................................. 14
- Powering-On Your System After Initial Setup .................................... 14

## Dock Surface Controls Overview ............... 15
- iPad Stand ......................................... 16
- Soft Knobs ........................................ 16
- Soft Keys ......................................... 17
- Left Control ...................................... 17
- Right Control and Vertical Touchstrip ....... 18
- Wheel and Horizontal Touchstrip ............. 18
- Transport ........................................ 19
- Channel Strip .................................... 19
- Control Room/Monitor ............................ 20
- Surface SHIFT ..................................... 20
# Appendix B. Avid S3 Dock Link Kit

## Using the Dock with Pro Tools

- Track Basics .......................................................... 21
- Adjusting Track Parameters with the Soft Knobs .......... 25
- Wheel ................................................................. 28
- Working with VCAs ...................................................... 29
- Working with Automation ........................................... 30
- Surround Panning .................................................... 34
- Monitoring ............................................................ 36

## Soft Keys

- Viewing Soft Key Assignments in the Soft Key Editor .... 38
- Using the Soft Key Editor ............................................ 41
- EuControl Surface Commands .................................... 44

## EuControl Software

- Accessing EuControl Settings .................................... 45
- Surfaces ............................................................. 46
- Workstations .......................................................... 48
- General ............................................................... 50
- Preferences ............................................................ 54
- Assign ................................................................. 56
- Layouts ............................................................... 57
- Soft Keys .............................................................. 57
- Restart EUCON Applications ....................................... 57

## Appendix A. Specifications

- Mechanical ............................................................ 58
- Environmental ........................................................ 58
- Dimensions ............................................................ 59
- Test Mode .............................................................. 59

## Appendix B. Avid S3 Dock Link Kit

- Installing the S3 Dock Link Kit .................................. 60

## Appendix C. Compliance Information

- Environmental Compliance ....................................... 64
- EMC (Electromagnetic Compliance) .............................. 65
- Safety Compliance ................................................... 66
Introduction

Welcome to the Pro Tools® | Dock studio controller and iPad dock from Avid®. The Dock uses Avid’s high-speed EUCON™ (Extended User Control) control protocol to enable fully integrated control of Pro Tools and other EUCON-compatible audio and video applications via a 100 MB/s Ethernet connection.

The Dock is designed to be used with Avid’s Pro Tools | Control app for iPad. The Dock/Control combination can also be used simultaneously with the Pro Tools | S3 studio controller, and/or with Avid Artist Mix media controllers. This guide focuses on using the Dock with the Control app.

EuControl Software

EuControl lets your workstation computer find, link, and communicate with the Dock and Control app via the EUCON protocol. EuControl also lets you set preferences for and customize the controls on your Dock, S3, or other Artist series media controller. EuControl software must be installed on the workstation computer before you can use the Dock with your application. You can also control applications on a secondary workstation computer by installing the separate EUCON Workstation software.
What’s Included
- Pro Tools | Dock control surface
- Power cable and power adapter
- Cat5e (350 MHz) Ethernet crossover cable
- Documentation pack, which includes the EuControl software Activation Card, Dock Welcome Card, Pro Tools | Dock Safety & Regulatory Guide, Health and Safety Guide, and a warranty card

Additional Required Equipment
- A supported Apple iPad with the most recent version of the Pro Tools | Control App from Avid. Pro Tools | Control requires a data (host) connection between the iPad and your primary workstation, using either of the following:
  - Wi-Fi*
  - Apple Lightning to USB 3 Camera Adapter + USB 2 Ethernet adapter connected to iPad running iOS 9.3.x or later. A Lightning cable connected to a power source such as the USB port on the Dock is required to power the Camera Adapter. For more information, visit www.apple.com.

*The Dock does not provide Wi-Fi; a wireless router is required. For more information, see the Pro Tools | Control Guide.pdf.

Optional Equipment
- A USB-Ethernet adapter or Thunderbolt-Ethernet adapter, if there is no available Ethernet port on your workstation.
- If your system also includes an S3 and you want to use it as an audio interface, a qualified AVB-compatible Ethernet switch is required.
- If your system also includes an S3, the Pro Tools | Dock Link Kit is available to mechanically attach the Dock to the S3. For more information visit S3-Dock-Link.

System Requirements and Compatibility
- One Dock can be used with EuControl Software at a time.
- One Dock can be used in conjunction with Pro Tools | Control, one Pro Tools | S3, one Artist Color, and up to four Artist Mix.
- Avid can only assure compatibility and provide support for hardware and software it has tested and approved. For compatibility information and other resources, visit: http://avid.force.com/pkb/articles/faq/Dock-Support

Registration
Review the enclosed Registration Information Card and follow the instructions on it to quickly register your purchase online. By registering, you become eligible to receive the following:
- Technical support information
- Software update and upgrade notices
- Hardware warranty information

About This Guide
This guide covers using the Dock control surface and Pro Tools | Control app (referred to as the Control app) with Pro Tools and other EUCON-compatible applications. This guide also covers how you can use the Dock/Control combination along with a Pro Tools | S3 control surface or supported Artist Series media controller.

For information about Dock support in DAWs and applications from our Development Partners, contact the manufacturer.
Conventions Used in This Guide

All of our guides use the following conventions to indicate menu choices and key commands:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>File &gt; Save</td>
<td>Choose Save from the File menu</td>
</tr>
<tr>
<td>Control+N</td>
<td>Hold down the Control key and press the N key</td>
</tr>
<tr>
<td>Control-click</td>
<td>Hold down the Control key and click the mouse button</td>
</tr>
<tr>
<td>Right-click</td>
<td>Click with the right mouse button</td>
</tr>
</tbody>
</table>

The names of Commands, Options, and Settings that appear on-screen are in a different font.

The following symbols are used to highlight important information:

💡 User Tips are helpful hints for getting the most from your system.

⚠️ Important Notices include information that could affect your data or the performance of your system.

🔍 Shortcuts show you useful keyboard or mouse shortcuts.

🔍 Cross References point to related sections in this guide and other Avid guides.

Hardware Switches on the Dock and S3 Control Surface

The names of switches on the Dock and S3 control surface are shown in bold, such as Sel. The two Surface SHIFT switches are indicated by bold text, in all-caps to distinguish them from references to the Multi Select/SHIFT Global Modifier switch (S3 only) and the Shift key on your computer keyboard.

Accessing Secondary Functions Using Surface SHIFT

The Surface SHIFT switches are used in conjunction with other switches to access a secondary layer of functions. The primary function of switches are shown directly on each switch. Most secondary functions are listed next to each switch, or on the switch but in black text with a white background. For example, for the Rec/A switch, Rec (track record enable) is the primary function and A (track Automation mode) is the secondary function. (You can swap the primary and secondary function for this switch in Eu-Control).

The following terminology is used to describe Dock SHIFT functions, for example:

To enable Do to All:
   • “Press and hold the Dock SHIFT switch then press the Do to Sel/Do to All switch.”

is written as
   • “Press SHIFT + Do to Sel/Do to All.”
How to Use this PDF Guide

These are some useful features of this PDF:

• The Bookmarks on the left serve as a continuously visible table of contents. Click a + symbol to expand that heading to show subheadings. Click the – symbol to collapse a subheading. Click on a subject heading to jump to that page.

• The Table of Contents provides active links to their pages. Select the hand cursor, allow it to hover over the heading until it turns into a finger. Then click to locate to that subject and page.

• Any text entry in blue is an active link. Click on the link to go to that section.

• Select Find from the Edit menu to search for a subject.

Resources

The Avid website (www.avid.com) is your best online source for information to help you get the most out of your Avid system. The following are just a few of the services and features available.

Account Activation and Product Registration

Activate your product to access downloads in your Avid account (or quickly create an account if you don’t have one). Register your purchase online, download software, updates, documentation, and other resources.

https://www.avid.com/account

Support and Downloads

Contact Avid Customer Success (technical support); download software updates and the latest online manuals; browse the Compatibility documents for system requirements; search the online Knowledge Base or join the worldwide Avid user community on the User Conference.

For the Dock visit:

https://www.avid.com/Dock-Support

For S3 visit:

http://www.avid.com/S3-Surface-Support

For Artist Mix and other Artist Series media controllers visit:


Products and Developers

Learn about Avid products; download demo software or learn about our Development Partners and their plug-ins, applications, and hardware.

https://www.avid.com/Products/index.html

Get Started Fast Video Tutorials

Watch video tutorials for Dock, S3, and other EuControl products on YouTube:

Get Started Fast with Pro Tools | S3 and Dock

You can find more videos, including the latest workflow tutorials, on the Avid website. Go to www.avid.com, view Products and select Pro Mixing. Follow the links for your controller and check the Learn and Support listings for video resources.
Installation and Setup

This section shows how to get your Dock set up as a studio controller, and consists of the following steps:

- Connecting the Dock
- Installing EuControl Software
- AutoLaunch Settings
- Updating Dock Firmware
- Installing and Connecting Pro Tools | Control
- Enabling EUCON in Pro Tools
- Confirming EUCON

Connecting the Dock

Connecting the Dock involves the following steps.

- Connecting Power
- Connecting Ethernet
- Powering the Dock On

Connecting Power

To connect your Dock to your workstation computer:

1. Connect the male (AC) end of the included power supply into a power outlet.

2. Connect the DC output cable from the power adapter to the DC In jack on the back panel.

Connecting the power cable to the DC In jack
Connecting Ethernet

Depending on your configuration requirements, you can connect the Dock directly to your workstation computer (the computer running Pro Tools or other DAW), to a router or switch that is then connected to your workstation computer, or to an S3 that is connected to your workstation computer.

⚠️ Standard routers and switches can be used if you are using the Dock without a Pro Tools | S3, or with an S3 but only using the S3 as a control surface. However, to use the built-in AVB audio I/O on the S3, the S3 must be connected directly to the computer or to an AVB-compatible Ethernet switch. Visit www.avid.com/Dock-Support for information on compatible peripherals.

To connect Ethernet between the Dock and your workstation computer:

1. Connect one end of an Ethernet Crossover cable into the Ethernet port on the back panel of the Dock.

2. Connect the other end of the Ethernet cable to an available Ethernet port on your computer, or to the computer’s Thunderbolt port using an Ethernet-to-Thunderbolt (or Ethernet-to-USB) adapter.

Or, if your system includes a Dock and an S3 you can connect the Dock to Network port B on the S3, and connect S3 network port A to your workstation.

⚠️ The Dock cannot connect to your workstation computer using a wireless connection. A hard-wired network connection is required.

3. If you want to connect the Dock to a local area network, or to connect additional Artist Series media controllers, connect the Ethernet cable to an Ethernet router or switch, and make sure the router or switch is powered on before powering on the Dock.

Joining the Dock to S3

If you are using the Dock along with an S3, you can use the Avid S3 Dock Link kit (not included) to securely attach them to each other. The Link kit lets you attach the Dock to either the left or right of S3 to keep the stable and aligned. You can install the Link Kit at any time. To learn how, see Avid S3 Dock Link Kit.

Powering the Dock On

To power the Dock on:

1. Press the power switch on the back of the Dock to the “on” position.

   The fader jumps and the LEDs blink during initialization.

When the Dock is initially powered on, but not yet attached in the My Surfaces list in EuControl Settings, the LEDs cycle from dim to light purple. When the Dock is attached in My Surfaces, the 12 switch LEDs in the center light solid purple. When attached and an application with Soft Keys is focused, the assigned Soft Key colors are shown in the switch LEDs.

2. When the Dock is finished initializing, proceed to Installing EuControl Software.
Installing EuControl Software

Next, install EuControl software on your workstation computer. The computer running media applications is referred to in this guide as a **workstation**. An Internet connection is required to download EuControl.

**To install EuControl software:**

1. Visit [www.avid.com/account](http://www.avid.com/account) and log into your Avid account.
   
   To create an account if you don’t already have one, follow the instructions on the included EuControl Activation card (visit [www.avid.com/activationcard](http://www.avid.com/activationcard), click to select EuControl, then follow the on-screen instructions to create an account.

2. When you are logged into your Avid account, click **Avid Software Activation and Download** (under **My Products**).

3. On the Activate Product page, enter your EuControl Activation Code exactly as it appears on your EuControl Activation card (included in the Welcome packet) then click the **Activate Product** button.

4. Follow the instructions on-screen to complete your product activation and download the latest EuControl software for your workstation computer platform (Mac or Windows).

5. When download is complete, locate the **EUCON_WorkstationUnifiedInstall** on your computer and double-click it to mount it (DMG on Mac) or uncompress it (ZIP for Windows), then launch the installer.

6. Follow the on-screen prompts until the Installer list is displayed (as shown at right). For a description of each option, select it (Mac) or hover the mouse over it (Windows only).

7. Select each option you want to install:
   
   - To install EuControl software, select **S3 / Dock / Artist / PT | Control**.
   
   - If you have already installed EuControl on your primary workstation and want to install onto an additional, external workstation, select **EUCON Workstation** (see Connecting a Second Workstation).

8. Click Continue (Mac) or Next (Windows), then click Install.
   
   When reminded that a restart is required, click Continue Installation (Mac) or Yes (Windows).

9. When installation is complete click Restart.
   
   After your computer restarts, EuControl software launches automatically and is running when its icon (which is unlit until the Control app is connected) appears in the Menu bar (Mac) or the System tray (Windows).

   *On 10.14/"Mojave" (only) you might need to add Pro Tools and EuControl to the Privacy list in Mac OS System Settings.*

**Mac** Wait up to 60 seconds. A lit EuControl icon in the menu bar indicates correct installation and your surface is attached.

**Windows** Wait up to 60 seconds. A lit EuControl icon appears in the system tray at the bottom of the screen. If you don't see the EuControl icon, it could be automatically hidden by Windows. Click on the small white arrow to show hidden icons.

---

![Lit EuControl icon in the Mac menu bar (left) and Windows system tray (right)](image-url)
10 If the lit EuControl icon does not appear, do any of the following:
   • See Add to add the Dock manually.
   • Restart EUCON Applications (see Restart EUCON Applications for more information).
   • Shut down the Dock and your computer, then turn them on (Dock first, then the workstation computer).
   • See www.avid.com/Dock-Support for the most current troubleshooting information.

11 Proceed to Updating Dock Firmware.

To uninstall items:
1 Launch the installer
   Items that are currently installed are selected (checked) and indicated as Installed.
2 Do the following:
   • To uninstall specific component, make sure it is not selected (no check mark).
   • To uninstall all EUCON applications, select Uninstall all applications.
   • To uninstall all User Preferences, select Uninstall User Preferences (your appsets will not be removed).
3 Click Continue (Mac) or Next (Windows).

AutoLaunch Settings
You can enable or disable auto-launch for EuControl, WSControl, and/or XMON using the new AutoLaunch selector.

To configure AutoLaunch on Mac:
1 Make sure EuControl or S6 WSControl is installed, then do the following:

Mac  Click on the EuControl or WSControl icon in the menu bar.

Windows  Right-click on the EuControl or WSControl icon in the System Tray at the bottom of the screen.

2 From the Auto-launch Apps sub-menu, choose any of the following (you can enable more than one):
   • EuControl (for S3, Dock, Pro Tools | Control, and Artist Series)
   • WSControl (for S6)
   • XMON
Updating Dock Firmware

After installing EuControl, make sure your Dock and other Artist Series or S3 media controllers are running the latest firmware. The firmware is provided within EuControl, so an Internet connection is not required.

To update firmware:

1. Click (Mac) or double-click (Windows) the EuControl icon and select EuControl Settings.
2. If necessary, click Surfaces to display the Surfaces tab.

   ![Surfaces tab](image)

3. Click PT | Dock in the My Surfaces list so it is highlighted.

   If the Dock does not appear in the My Surfaces list, add it manually by clicking to select it in the All Surfaces list and then click Add.

4. Click Update Firmware. If the Update Firmware dialog indicates that the surface is up to date, no further action is necessary.

5. If the firmware needs to be updated, follow the instructions in the Update Firmware dialog box to proceed, and make sure to observe the following guidelines when updating firmware:
   - Ensure that the Dock is connected to a trustworthy power source.
   - Do not power off the Dock during the update or attempt to interrupt the update.

   The status of the firmware update is shown in the EuControl dialog.

6. Click Done when the firmware update is complete, then proceed to Enabling EUCON in Pro Tools.
Installing and Connecting Pro Tools | Control

Before proceeding, make sure your iPad is running the most recent version of the Pro Tools | Control app, and that it appears in the My Surfaces list in EuControl. See the Pro Tools Control Guide.pdf for instructions on installing, and connecting the app.

After you have installed the Control app and connected it to your network, place your iPad in the stand built into the Dock.

- The Dock comes with an iPad Mini Riser pre-installed which increases the viewing angle for iPad Mini and also accommodates iPad Air. The iPad Mini Riser can be removed if not needed.
- If using an iPad Air, use a right-angle Lightning cable to keep the cable clear of the knobs.
- If using an iPad Pro 10.5-inch, you can order the Pro Tools | Dock 10.5" iPad Pro Adapter from the Avid Store.

To keep your iPad charged, connect your iPad to the USB port on the back of the Dock.

![iPad mounted in Dock (shown at left) and removable Mini Riser (shown at right)](image)

USB port on the back panel of the Dock

💡 The back panel USB port is for charging and powering your iPad, only. Data communication with EuControl requires a Wi-Fi connection, or an Apple Camera Connection Kit and adapters. For more information, see the Pro Tools | Control Guide.pdf.
Enabling EUCON in Pro Tools

When you first connect your Dock, you must enable EUCON in Pro Tools, EUCON subsequently remains enabled in Pro Tools unless you disable it. To enable EUCON in other DAWs, see the documentation provided by the manufacturer.

To enable EuControl in Pro Tools:
1. Launch Pro Tools. If the Dashboard dialog appears, close it.
2. Choose Setup > Peripherals, and click the Ethernet Controllers tab.
3. Select Enable EUCON.

Enable EUCON check box

⚠️ While Pro Tools is connected to a EUCON surface do not uncheck to disable and re-check to enable without a complete restart of all components (surfaces and Pro Tools computer) after disabling and before re-enabling.

4. Click OK. You do not need to configure any other Ethernet Controllers settings. These settings do not apply to EUCON. Pro Tools scans your system until it identifies attached EUCON-compatible hardware. When Pro Tools finishes scanning your system, your controllers are ready to use with Pro Tools.

⚠️ Before ever de-selecting Enable EUCON be sure to go to EuControl Settings > Surfaces and remove all attached surfaces.

5. Proceed to Confirming EUCON.

💡 To learn how to configure EuControl for other EUCON-compatible applications see the EUCON Application Setup Guide.pdf.
**Confirming EUCON**

To confirm installation and communication:

1. Make sure you have enabled EUCON.

2. Open a session if one is not already open.

3. Verify that the Tracks or Mixer view in the Control app shows the track names from the Pro Tools session.

   ![Pro Tools | Control Tracks view showing the first 16 tracks in a session](image1)

   - In the Pro Tools Mix window, verify that the names of the tracks currently banked to the channel strip on the dock (or to strips on S3 if your system includes one) are highlighted with blue-green borders.

   ![Pro Tools Mix window showing tracks currently banked to the S3 channel strips](image2)

4. Proceed to any of the following:
   - To connect a second workstation computer, go to **Connecting a Second Workstation**.
   - To connect a footswitch, go to **Connecting a Footswitch**.
   - For instructions on using your S3 after initial installation, see **Powering-On Your System After Initial Setup**.
Connecting a Second Workstation

The Dock can control applications running on a second computer connected to the same network as the primary computer, referred to in this guide as a workstation. If EuControl is running on the same workstation as all your audio/video applications you can skip these instructions.

To be able to control a second workstation:

1. Quit (Mac) or Exit (Windows) Pro Tools and any other EUCON applications running on any of your workstations.

2. Transfer the EUCON_WorkstationUnifiedInstall file onto the second computer. After downloading, make sure the installer is mounted (DMG on Mac) or uncompressed (ZIP for Windows).

3. Double-click the Install EUCON Workstation Unified installer, then select the EUCON Workstation option and click Next.

4. When installation has finished, go to Spotlight (Mac) or Search (Windows), and type “MC Client” to locate the application, then launch MC Client.

5. On the primary workstation, do each of the following:
   - Open EuControl Settings, go to the Workstations tab, and click to enable Enable External Workstations. Follow the prompt and wait until EUCON applications restart. You must also manually relaunch your DAW.
   - Go to System Preferences > EUCON (Mac) or Control Panel > EUCON (Windows), click the Network Interface selector and choose the port used for your EUCON network connection (such as Ethernet 1).

6. On the secondary workstation, do each of the following:
   - Go to System Preferences > EUCON (Mac) or Control Panel > EUCON (Windows).
   - Make sure the Network Interface selector shows the correct network port for your EUCON connection.
   - If it is not already enabled, click to enable Enable as External Workstation. Follow the prompt and wait until EUCON applications restart. You must also manually relaunch your DAW.

7. On the primary workstation, open the EuControl Settings window by doing either of the following:
   - On Mac, click the EuControl icon on the taskbar and select EuControl Settings.
   - On Windows, double-click the EuControl icon in the system tray and select EuControl Settings. If you don’t see the EuControl icon, it could be automatically hidden by Windows. Click on the small white arrow to show hidden icons, then double-click the EuControl icon.

8. In EuControl Settings, go to the Workstations tab.

9. Select your secondary workstation in the All Workstations list, then click Add to add it to the My Workstations list.
You can now switch between workstations by doing either of the following:

- On the Dock, S3, or other Artist Series media controller, press the **Workstation** switch. For example, on the Dock press **SHIFT+App/Workstation**.
- In the Workstations tab of EuControl Settings, select the desired workstation in the My Workstations list and click **Attach**. If you are using the Control app without any other Artist Series controllers, you must use this method to switch workstations.

See **Workstations** for information on the other features of the Workstations tab.

---

**Connecting a Footswitch**

The Dock has a 1/4-inch footswitch input on the back panel, which can be used to punch in and out of recording in your DAW, or to control Talkback when a supported monitor solution is also connected (such as MTRX or XMON). See **Footswitch** for more information on configuring the footswitch.

---

**Kensington Lock**

The Dock provides a Kensington Lock to secure your unit.

---

**Powering-On Your System After Initial Setup**

After the initial installation and setup, your system must be powered on in a specific order, as follows:

1. If connecting to a router, connect the Dock and any other Artist Series media controllers to the router, connect the router to the workstation computer, and power on the router.
2. If connecting directly, connect the Dock to the workstation computer.
   - If your system also includes an S3, confirm that S3 is in Studio Mode (see the **Pro Tools S3 Guide.pdf** for instructions).
4. Once the Dock is finished initializing, power on the workstation computer.

💡 If the Dock is not recognized by EuControl on your workstation computer (for example, because you powered the Dock on after powering on the workstation computer), click the unlit EuControl icon in the menu bar (Mac) or System tray (Windows) and choose **Restart EUCON Applications...** to relaunch EuControl and re-initiate the connection.
Dock Surface Controls Overview

This section provides an overview of the surface controls on the Dock when using it with the Control app and EUCON-compatible applications.

The primary function of each switch is labeled directly on the switch. The secondary (**SHIFT** or **ALT**) function is labeled next to the switch.

For audio workflows, see *Using the Dock with Pro Tools*.

**Pro Tools | Dock top panel**

1 – iPad Stand  
2 – Soft Knobs  
3 – Soft Keys  
4 – Left Control  
5 – Right Control and Vertical Touchstrip  
6 – Wheel and Horizontal Touchstrip  
7 – Transport  
8 – Channel Strip  
9 – Control Room/Monitor  
10 – Surface **SHIFT**
**iPad Stand**

Provides a stand for securely mounting an iPad (not included) running the Pro Tools | Control app. The included Mini-Riser increases the viewing angle for iPad Mini tablets, or it can be removed to fit larger iPad models in the stand. The **Soft Knobs** surrounding the iPad stand correspond to controls on-screen in the app, as do the **Soft Keys** below the stand.

A back panel USB port lets you charge your iPad via Lightning cable while in the Dock. This USB port is for charging, only, it is not a data/host connection.

**Soft Knobs**

These eight touch-sensitive encoders provide parameter control over the currently focused knobset displayed in the Control app, such as EQ or Dynamics controls in Channel view, and pan controls in Mixer or Channel view. The Soft Knobs are dual-function encoders that can be rotated to select and adjust values, and pressed to toggle certain functions.

- The term “knobset” refers to different sets of parameter types, such as input, EQ, Dynamics, and sends.

Working with different knobsets from the Soft Knobs requires just a few simple steps:

1. Select or attention a track, or select a function or parameter.

   For example, on the iPad use **Channel** view to attention a specific track and function. Or from an S3, press a Channel Encoder Assign switch to focus that function (such as **EQ**). The Control app displays available parameters for the track or function.

2. To navigate to or select a track parameter or other choice shown on the iPad screen, press the Soft Knob next to that choice.

3. To adjust a parameter shown on the iPad, rotate a Soft Knob. Rotating slowly adjusts in small increments (“fine” resolution); rotating faster adjust in larger increments.
Soft Keys

These sixteen switches engage the corresponding Soft Key assignment in the Control app. Default (factory) Soft Key assignments are available automatically, and you can customize assignments using the Soft Key Editor in EuControl Settings.

In the default Pro Tools appset, the two Soft Keys at the far left are assigned to the Fader and Soft Keys buttons. The two Soft Keys at the far right are assigned to ^ and v, which scroll the displayed Soft Keys up or down, respectively. The twelve switches in the center are assigned to the Soft Keys shown across the bottom of the Control app screen.

The 16 Soft Key switches on the Dock are separate from the Soft Keys view in the Control app, which provides multiple pages of Soft Keys, each with four rows of six Soft Keys. For more information, see Soft Keys.

Left Control

These twelve switches provide dedicated automation controls.

Primary switch functions include track Automation mode selectors such as Write, Touch, Latch, Touch Latch, Trim, Read, Join, Auto Join, Suspend, Off, and (Automation) Window. These switches let you select the corresponding Automation mode for the currently attentioned track, all selected tracks, or all tracks. By default, the switch LEDs in the Left Control section indicate track automation modes globally for the session. For example, if the session contains some tracks in Read and other tracks in Touch automation modes, the Read and Touch switch LEDs on the Dock are lit. You can instead have switch LEDs only indicate automation mode for the currently attentioned track using the Dock Automation Mode Buttons Follow Attentioned Channel setting.

Secondary switch functions, accessed by enabling the ALT switch, provide advanced automation commands including Preview, Punch Preview, Suspend Preview, Capture, Punch Capture and AutoMatch, as well as Write To... commands (All/Sel, Start, End, Punch, and Next). The ALT switch is a latching “page 2” switch that only affects the switches in the Left Control section. Using ALT lets you select advanced automation functions while still being able to access primary or secondary switch functions in other sections.

For complete information on how to assign track Automation mode, and how you can optimize switch and LED behavior, see Working with Automation.
**Right Control and Vertical Touchstrip**

These twelve switches include controls for navigation (such as **Bank** and **Nudge**), Wheel modes (such as **Jog**, **Shuttle**, **Zoom**, and **Scroll**), and utility controls (such as **OK**, **Cancel** and the **App/Workstation** switch).

The EUCON **Show Me** icon is shown between the **Save** and **Cancel** switches. Pressing **Save** + **Cancel** simultaneously shows Soft Key assignments in EuControl.

**Vertical Touchstrip**

To the right of the switches is a vertical, continuous Touchstrip with four zones labeled 1, 2, 3, and 4 from top to bottom. By default, these zones are assigned to the following functions:

<table>
<thead>
<tr>
<th>Zone</th>
<th>Primary Layer</th>
<th>SHIFT Layer</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>unassigned</td>
<td>Preferences</td>
</tr>
<tr>
<td>2</td>
<td>unassigned</td>
<td>Task Manager</td>
</tr>
<tr>
<td>3</td>
<td>unassigned</td>
<td>Workspace</td>
</tr>
<tr>
<td>4</td>
<td>unassigned</td>
<td>Video window</td>
</tr>
</tbody>
</table>

The primary layer functions are left unassigned so you can customize them however you choose.

For information on how you can customize the touchstrip, see **Touchstrip Soft Key Assignments**.

**Wheel and Horizontal Touchstrip**

The Wheel can be used to jog, shuttle, scroll, and zoom, mark in and out points, move selections, and adjust clip gain, as determined by the Wheel mode switches in the **Right Control and Vertical Touchstrip** section.

Below the Wheel is a horizontal continuous Touchstrip with four zones labeled 1, 2, 3, and 4 from left to right. By default, these zones are assigned to the following functions:

<table>
<thead>
<tr>
<th>Zone</th>
<th>Primary Layer</th>
<th>SHIFT Layer</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>unassigned</td>
<td>Mix/Edit Window toggle</td>
</tr>
<tr>
<td>2</td>
<td>unassigned</td>
<td>Hide All Floating Windows</td>
</tr>
<tr>
<td>3</td>
<td>unassigned</td>
<td>Memory Locations Window</td>
</tr>
<tr>
<td>4</td>
<td>unassigned</td>
<td>System Usage Window</td>
</tr>
</tbody>
</table>

The primary layer functions are left unassigned so you can customize them however you choose.

For information on how you can customize the touchstrip, see **Touchstrip Soft Key Assignments**.
Transport

These seven switches provide basic Transport commands RTZ (Return to Zero), Rewind, Fast Forward, Stop, Play, Record, and Loop on/off in their primary layer, and extended Transport commands in the **SHIFT** layer.

The following table lists all the primary and secondary functions of the Transport switches.

<table>
<thead>
<tr>
<th>Primary Layer</th>
<th>SHIFT Layer</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;&lt; (Rewind)</td>
<td>Previous</td>
</tr>
<tr>
<td>&gt;&gt; (Fast Forward)</td>
<td>Next</td>
</tr>
<tr>
<td>□ (Stop)</td>
<td>User (assignable in EuControl)</td>
</tr>
<tr>
<td>&gt; (Play)</td>
<td>Pre/Post-Roll on/off</td>
</tr>
<tr>
<td>○ (Record)</td>
<td>Record Mode</td>
</tr>
<tr>
<td>Loop (playback)</td>
<td>Loop Record</td>
</tr>
</tbody>
</table>

Channel Strip

The Dock provides one channel strip with a **Solo** switch, a **Mute** switch, a 100mm motorized touch-sensitive fader, a channel select (**Sel**) switch, a Record Enable (**Rec**) / Automation Mode (**A**) switch, and a level meter.

**Solo**

The **Solo** switch lights yellow when that track is soloed.

**Mute**

The track is muted (off) when the strip **Mute** switch is lit, and is on (unmuted) when not lit.

**Fader**

The fader controls the level for the track assigned to the channel strip. It is motorized so it reflects changes made in the application, such as automation. It is also touch sensitive, which some applications use for automation.

- When the **Select by Touch** General preference is selected in the EuControl Settings application (see **Select by Touch**), touching a fader selects that track in the application and attentions it on that strip. This is the same as pressing the fader **Sel** switch.
- Holding down the Option (Mac) or Alt (Windows) key on your computer keyboard and touching a fader sets it to unity gain.
- Holding down **Surface SHIFT** and touching the fader also resets it to unity.

💡 *On systems that include an S3 or other controller, the Dock fader ignores fader Flip.*
Channel Sel and Rec/A Switches

The channel strip features channel Sel and Rec/A switches that operate as follows:

**Sel** Selects that track in the application, and attentions it.

*In Pro Tools and other applications, multiple tracks can be selected, but only one can be attentioned. In this case, the attentioned track is the last one selected.*

**Rec/A** Record-enables a track in the application.

- In Pro Tools, the **Rec** switch flashes red to indicate that track is enabled (armed) for recording, and is lit solid when recording is in progress.
- Pressing a lit **Rec** switch disables that track for recording.

**A (SHIFT + Rec/A)** Changes the automation mode for a track. The selected automation mode appears in the channel strip (Mixer view) and Track tile (Tracks view) on-screen in the Control app.

Configuring the Rec/A Switch Priority

You can swap the default function of this switch in EuControl. When swapped, the default function (without **SHIFT**) changes the track automation mode, and the **SHIFT** function record enables the track. For more information, see [Rec/Auto Switch Press](#).

Control Room/Monitor

This encoder defaults to Control Room level, and its **SHIFT** function to Monitor level in supported applications. The Monitoring page in the Pro Tools Control app lets you assign and manage monitor controls. The Monitoring page supports any hardware or software application with a EUCON Monitor, such as Pro Tools | MTRX, Avid XMON, Studio Monitor Pro 2, as well as Nuendo, Cubase, and Pyramix.

Main Level and Cut (mute) are also supported in Pro Tools without MTRX or XMON (requires Pro Tools 18.7 or higher) when you [Enable EUCON Monitor](#).

Surface SHIFT

Most switches have secondary functions that are shown next to each switch (such as **Bank/<Nudge**, where **<Nudge** is the secondary function). To access these secondary functions, use either of the two **SHIFT** switches located at the lower-left and lower-right sides of the Dock. **SHIFT** can be engaged momentarily or latched on.

To engage Surface SHIFT momentarily:

- Press and hold the **Surface SHIFT** switch.

To latch **SHIFT** on:

- Press and release either **Surface SHIFT** switch. **Surface SHIFT** is lit when engaged; press either **Surface SHIFT** switch to unlatch.
Using the Dock with Pro Tools

This section provides examples of using the Dock and Control app with the latest version of Pro Tools.

You can also watch video tutorials for Dock, S3, and other EuControl products on YouTube:

Get Started Fast with Pro Tools | S3 and Dock

You can find more videos, including the latest workflow tutorials, on the Avid website. Go to www.avid.com, view Products and select Pro Mixing. Follow the links for your controller and check the Learn and Support listings for video resources.

Track Basics

This section shows how to select, bank and nudge tracks to assign them to the Dock channel strip to be able to adjust track volume, solo, mute, record enable, or select a track automation mode.

Selecting Tracks

Selecting a track also attentions it, assigning it to the Dock channel strip and selecting it in Pro Tools. You can select tracks in Mixer or Tracks view in the Control app, on-screen in Pro Tools, and/or from S3 (if present).

To select and attention a track in Mixer view:

- Tap the track name under the fader for the desired track. A blue rectangle surrounds the selected track’s fader strip, and surrounds the selected track in the Universe Scroller.

To select a track in Tracks view:

1. Tap Select in the Toolbar to enable it (lit).

2. Tap the desired track tile. A blue rectangle surrounds the track tile, and surrounds the selected track in the Universe Scroller.

S3 and Artist Series Note

S3 and other Artist Series media controllers provide additional ways to select and/or attention tracks. When these units are used with a Dock, the attentioned track will always be assigned to the fader strip on the Dock.

💡 With Pro Tools, you can configure your controllers to follow on-screen actions by configuring Surface Attention Follows DAW settings. You can also select/attention a track by touching a fader by enabling Select by Touch in the EuControl software.

For more information on selecting and attentioning tracks on S3, see the Pro Tools S3 Guide.pdf.
Surface Attention Follows DAW
(Requires Pro Tools 2019.5)

You can optimize how EUCON surfaces react to actions on-screen in your DAW using the Attention Most Recently Clicked DAW Area options in the General tab of EuControl Settings.

Enable any available setting to control when a mouse click tells the surface to attention a track. For example, if Edit Window is enabled and you click in the timeline or clicking/selecting a clip in your DAW, that track is automatically attended on your controller. If Edit Window is not enabled, clicking in the timeline or clicking/selecting a clip will not attention that track.

⚠️ If using Pro Tools 2018.12 or earlier, consider disabling these settings to avoid possible undesirable behaviors.

Additional Information for Attention Triggers

<table>
<thead>
<tr>
<th>Attention Setting</th>
<th>Trigger</th>
<th>Additional Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track Name</td>
<td>Clicking a track name in Mix or Edit window</td>
<td></td>
</tr>
<tr>
<td>Fader</td>
<td>Clicking a track volume fader in Mix window</td>
<td></td>
</tr>
<tr>
<td>Edit Window</td>
<td>• Clicking in a track/playlist lane in the timeline&lt;br&gt;• Keyboard shortcuts that move the insertion or section between tracks (such as Command Focus “p” and “;”). See “Edit Selection Move Up / Down” below.</td>
<td>• When clicking, the attention trigger is only based on the initial mouse click location. If you define a selection spanning multiple tracks, or bound an edit group, the attentioned track is based on the first point of contact on the edit timeline.</td>
</tr>
<tr>
<td>Plug-Ins</td>
<td>• Clicking to open a plug-in window&lt;br&gt;• Clicking anywhere in the plug-in window (including the header with automation, Librarian and the Target icon)</td>
<td></td>
</tr>
<tr>
<td>Pan Controls</td>
<td>• Clicking a pan knob or puck in the Mix window&lt;br&gt;• Clicking anywhere within a floating Pan window&lt;br&gt;• Clicking on a pan puck in the I/O view of the Edit window</td>
<td>Note that clicking on a pan control in the I/O view of the Edit window will not trigger attention.</td>
</tr>
<tr>
<td>Send Controls</td>
<td>• Clicking to open a send window&lt;br&gt;• Clicking anywhere within an open send window (including the window Target)</td>
<td>Note that clicking a send control in any Expanded Sends view will not trigger attention.</td>
</tr>
<tr>
<td>Edit Selection Move Up / Down</td>
<td>Using the computer keyboard or EUCON key commands to move the edit cursor or a selection up or down. For example, pressing “p” to move up or “;” to move down will attention the last track in which the cursor lands.</td>
<td>In Pro Tools make sure to enable Link Track and Edit Selection</td>
</tr>
</tbody>
</table>
Attention on Select Button Press and Auto-Bank to Clicked Track

These settings let you further optimize workstation and controller interaction.

- Enable **Attention on Select Button Press** to have track Attention follow strip Sel (Select) and/or tapping to select a track in Tracks view in the Control app.
- Enable the **Auto-Bank to Clicked Track** setting to have controller banking follow Attention Most Recently Clicked DAW Area settings. For example, when Auto-Bank to Clicked Track and Track Name are enabled, clicking a track Name banks that track onto the surface and attentions it. If Track Name is not enabled, clicking a track name will not bank or attention that track. Banking will only occur if the selected track is not already banked to a strip. In addition, Auto-Bank to Clicked Track and Auto-Bank to Selected Track are mutually exclusive (enabling either disables the other) to best support applications which may or may not support the Attention Most Recently Clicked DAW Area settings.

💡 When using a DAW that does not directly support these new features, the previously available “Attention most recently selected track” setting remains available. When using a DAW that does directly support these new features, “Attention most recently selected track” is not available.

Banking

You can use the **Bank** and **Nudge** switches to navigate through tracks shown in the Control app. By default, Bank and Nudge switches on the Dock only bank the Control app. To have tracks shown in the focused DAW follow, enable the **App banks DAW** option in the Control app local options (gear icon).

On systems that include an S3 or other Artist Series media controller, the **Bank** and **Nudge** switches on those controllers affect all connected surfaces (but not the Control app).

**To bank tracks:**

1. Press `< Bank` to bank the previous set of eight tracks, or `Bank >` to bank to the next set of eight tracks.

2. Press the `SHIFT + Bank>/Nudge >` switch to nudge tracks one channel to the right. If tracks 1–16 were assigned to fader strips 1–16, tracks 2–17 are now assigned to the 16 fader strips.

3. Press the `SHIFT + < Bank/< Nudge` switch to nudge tracks on channel to the left.

![Nudge and Bank switches](image)
Adjusting Track Volume, Solo, and Mute

Once a track is assigned to the Dock channel strip, you can adjust its volume, solo, and mute using the controls in the strip.

To adjust track volume:
- Adjust the fader for that track.

To reset the fader to default (0 dB):
- Hold SHIFT and touch the fader.

To solo or mute a track:
- Press the Solo or Mute switch.

You can also adjust volume, solo and mute of any track in the Control app.

To adjust track volume in the Control app:
- Tap Mixer to show Mixer view, bank to the desired track, then touch the desired fader and slide vertically.

To adjust track volume in Tracks view:
1. Tap Tracks to show Tracks view, tap a track tile, then tap Fader (or press its corresponding Soft Key switch on the Dock).
2. In the Fader pop-up, touch the fader and slide vertically.
3. Do either of the following:
   • Tap another track tile to adjust its level.
   • Tap Fader again to close the Fader pop-up.

To reset a track’s fader level to default (0 db):
- Double-tap a fader cap.

Record Enabling Tracks

You can record enable tracks from the Dock channel strip, and from Mixer or Tracks view in the Control app. A track must have a valid input to be record enabled.

To record enable a track from the Dock channel strip:
- Press the channel Rec switch. The switch flashes red.

You can swap the primary and SHIFT functions of the Rec/A switch in the General tab of EuControl Settings. For more information, see General.

To record-enable tracks in Mixer view:
- Tap Mixer, bank to the desired track, then tap the record-enable button for each track you want to record to.
  The fader cap for each record-enabled track lights red and the record enable button blinks red.

To record-enable tracks in Tracks view:
1. Tap Tracks, bank to the desired track, then tap the RECORD track function button so it is highlighted.
2. Tap the track tiles for the tracks you want to record to.
  The record-enable indicator for each track blinks red.
Adjusting Track Parameters with the Soft Knobs

The combination of the Control app and Dock provide a powerful and intuitive way to adjust most track parameters.

- **Channel** view lets you quickly navigate among track parameters by selecting a parameter type such as Inserts, Input, or EQ in the Function scroller.
- The Soft Knobs surrounding the iPad automatically map to whichever parameters you are viewing in the Control app.

To start using the Soft Knobs:

1. See [Selecting Tracks](#) to learn how to attention a track to the Dock.
2. In the Control app, tap **Channel** if it is not already selected. Channel view appears on the iPad.

The upper part of Channel view provides the same Tab bar and Universe Scroller as Tracks view, along with a single row of Track tiles. Along the bottom of Channel view is the same Toolbar as in Tracks view, letting you view Transport controls or Soft Keys. The other elements of Channel view are the following (numbers refer to the figure, above).

1. **Function Scroller** Tiles to select the desired function, such as Inserts, Input, Dynamics, EQ, Sends, Pan, Group, and Mix.
2. **Function View** Four parameter blocks on each side, each showing their currently assigned parameters. Parameter blocks align with, and correspond to, the Soft Knobs on the left and right sides of the Dock. The center of the Function View varies with the chosen function.
Using Channel View to Adjust Plug-Ins, Dynamics, EQ, Sends, and Pan

To use Channel view:

1. Tap a Function block.

   The lower area of the screen displays parameters for the chosen function.

2. To adjust a displayed parameter, rotate and/or press the corresponding knob on the Dock. For example:
   - To adjust Low-Mid Band Gain shown above, tap the EQ function block and then rotate the lower left Soft Knob on the Dock.
   - To reset a variable parameter (frequency, gain, or Q) to its default setting, press the corresponding encoder.
   - To use the Dock knobs to pan, tap the Pan function block and then rotate two upper left Soft Knobs as appropriate.

3. For two-state or in/out parameters, tap the Sel or In buttons in the corresponding slot. For example:
   - To turn a band on or off, tap the In button for a band’s Gain.
   - To access Q for a band in EQ3 tap the Sel button in the slot for the desired frequency. That slot displays Q. Tap Sel again to return to Freq.
   - To change filter Type (such as Peak or Shelf), tap the In button for the desired band’s Frequency control.

Additional parameters might be available with other plug-ins, so check with the manufacturer for more information.

Plug-in Parameter Mapping

Plug-in parameter mapping depends on the selected knobset (function), as follows:

**Inserts** In the Inserts knobset parameters are mapped according to the manufacturer’s specifications. Parameter mapping can vary between plug-ins, even of the same type.

**EQ and Dyn** In the EQ and Dyn knobsets, parameter mappings are standardized across types of plug-ins. For example, the threshold controls for two compressor plug-ins from different manufacturers appear on the same encoder.

Window Control

You can link on-screen DAW windows to follow actions in the Control app by configuring the **Open/Close Window on Workstation When Editing** settings in EuControl.
Assigning Track Input and Output, Inserts, Sends, and Group Membership

You can route track I/O, work with track groups, and assign plug-ins and sends using the Dock and Channel view in Pro Tools | Control.

The following example shows how to assign track input. The same basic steps apply for track output and group functions.

Assigning Track Input

To assign track input:
1  Attention a track (see Selecting Tracks to learn how to attention a track to the Dock).
2  In the Control app, tap Channel if it is not already selected.
3  In the Function scroller, tap Input.
   Any currently assigned input is shown in the upper left slot of the Function view.
4  Press the upper left knob on the Dock (the knob that corresponds to the upper left slot in the Function view).
   The next level of choices appears in slots in the Function view. For Input, the choices are interface and bus.
5  Rotate the knob for interface or bus (or swipe the on-screen input selector) to select the desired input source.
6  Tap the In button on-screen to assign the selected input source.

Inserting a Plug-In

The next example shows how to insert a plug-in on a track. The same basic steps apply for assigning sends.

To assign a plug-in to a track:
1  Attention a track (see Selecting Tracks to learn how to attention a track to the Dock).
2  In the Control app, tap Channel if it is not already selected.
3  In the Function scroller, tap Insert.
   Any currently assigned plug-ins are shown in slots of the Function view.
4  To adjust a plug-in already inserted on the track, press the knob for that plug-in then use the knobs and on-screen buttons to adjust parameters.
5  To insert a new plug-in, tap the Config button on-screen (in the upper part of the Function view).
   The Config button lights orange.
Press a knob corresponding to the insert slot (a–j) where you want to add the plug-in. To navigate to other slots (such as i or j) tap their block in the center of the Function view.

The next level of choices for Insert assignment appears in slots in the Function view. For plug-ins, the choices are noinsert, plug-in, i/o, and default plug-ins such as Pro Tools EQ3 and Dyn3Comp/Lim.

Do any of the following:
• Press the knob for noinsert to leave the track unchanged.
• Press the knob for plug-in to see the next level of choices (such as Categories, or Manufacturer). Press any knob to navigate to the next level and to select an available plug-in.
• Press the knob for i/o to assign a hardware insert
• Press the knob for any shown Favorites to insert that plug-in (such as EQ37-Band).
• Tap the on-screen < button (to the left of Config) to return to the previous level.

For more information on working with plug-ins and sends, see the Pro Tools Control Guide

You can also link on-screen DAW windows to follow actions on the Dock and/or Control app by configuring the Open/Close Window on Workstation When Editing settings in EuControl.

Wheel

You can use the Wheel to zoom and scroll, Jog/Shuttle, and mark In and Out points.

To use the Wheel:
1 Press the desired switch in the Right Control section:
   • To zoom the Edit window, press Zoom H (horizontal) or Zoom V (vertical).
   • To scroll, press SHIFT + Zoom H or Zoom V.
   • To Jog, press Jog.
   • To Shuttle, press Shuttle.
   • To mark In (edit selection start), press SHIFT + Jog.
   • To mark Out (edit selection end), press SHIFT + Shuttle.
   • To move a selection, press Move Sel.
2 Spin the wheel left to decrease/move earlier, or to the right to increase/move later.
Working with VCAs
(Pro Tools | Dock with Pro Tools | Control and Pro Tools | S3 Only)

VCA Spill lets you quickly access (spill) only those channels assigned to the selected VCA Master track to the channel strips on an S3.

When the Dock is used with an S3, you can configure whether the VCA Master is assigned to the Dock channel strip or the designated S3 strip when a VCA is spilled in Single-Master Mode. You can also optimize whether or not VCA Spill overwrites any currently recalled Layout. For more information, see Preferences.

You can spill VCAs from Pro Tools | Control whenever an S3, Dock, Artist Mix, or Artist Control are present.

To spill a VCA from Pro Tools | Control:

1. In EuControl Settings, go to the Preferences tab and make sure to enable Auto Spill VCA from Control App Attention.

2. In the Control app, go to the Tracks screen.

3. Tap a VCA.
   Members of the selected VCA spill onto the S3, Artist Mix, and Artist Control. When a Dock is present, spill and Master follow current S3 VCA Spill settings.

While a VCA is spilled and the Dock fader is assigned to <attentioned track> in EuControl Settings > Assign tab:
- On the Dock, the upper-left Soft Key (the Fader button) flashes green. On the Control app, the Spill indicator also flashes green as shown in the figure below.
• You can select another track and the Dock fader (including its Sel and Rec switches) focuses on that recently selected track. The Spill indicator in the Control app and the Fader button on the Dock flash yellow. Spill remains active on the S3 or other multi-fader surface.

• To un-spill the VCA, tap the flashing green Spill indicator button (the Fader button at the upper-left of Soft Keys), or tap the track block again in the Control app. You can also tap the flashing green indicator on-screen in the Control app.

• To display the Floating fader for the currently selected track in the Control app, tap the Fader name display or press the Fader button. While the Floating fader is displayed, the Fader button on the Dock lights yellow (press to turn it off and collapse the Floating fader).

To initiate VCA Spill from an S3, see the Pro Tools S3 Guide.pdf.

---

**Working with Automation**

This section shows the different ways you can set track Automation modes and use advanced automation features.

**Setting Track Automation Modes**

You can set the Automation mode for one or more tracks in the following ways.

**Setting Automation Mode for a Single Track**

You can set track Automation mode for a single track using the dedicated mode switches on the Dock along with the track Sel switch. The Automation mode switch LEDs light to indicate all automation modes currently enabled on any tracks in the session. This is the default procedure for selecting track Automation mode, as determined by the Dock Automation Mode Buttons Follow Attentioned Channel setting (not enabled, by default).

**To set the automation mode for a single track:**

1. Attention a track to bring it to the Dock fader strip (see Selecting Tracks to learn how to attention a track to the Dock).

2. On the Dock, press and hold the switch in the Left Control section for the desired track automation mode (Write, Touch, Latch, TouchLatch, Trim, Read, or Off).

3. Press the Dock strip Sel switch.
   The current Automation mode is shown in Mixer and Tracks view, in the corresponding channel display on the S3 (if present), and on-screen in Pro Tools.
   On the Dock, the automation switch LEDs indicate the current mode(s) globally, lighting to show all modes currently set for any tracks in the session. In the figure to the right, one or more tracks are in Write and Latch modes.

**To set the automation mode for multiple tracks:**

1. Select one or more tracks.

2. Do either of the following:
   • To set the automation mode for all selected tracks, press Do to Sel.
   • To set the automation mode for all tracks in the session, press Do to All (SHIFT+Do to Sel).

3. Press the switch in the Left Control section for the desired track automation mode (Write, Touch, Latch, TouchLatch, Trim, Read, or Off).
   The current Automation mode is shown in Mixer and Tracks view, in the corresponding channel display on the S3 (if present), and on-screen in Pro Tools. On the Dock, the automation switch LEDs indicate the current mode(s) globally, lighting to show all modes currently set for any tracks in the session.
Using the Automation Mode Switches for Direct Assign

When the Dock Automation Mode Buttons Follow Attentioned Channel setting is enabled, you can set track Automation mode for the currently attentioned track directly using the mode switches in the Left Control section (you do not need to press Sel). In addition, the Automation mode switch LEDs light to indicate automation status of the currently attentioned track, only.

To set track automation mode for one or more tracks in “direct” mode:

1. Make sure the Dock Automation Mode Buttons Follow Attentioned Channel setting is enabled (EuControl Settings > General tab).
2. Attention a track to bring it to the Dock fader strip, or select multiple tracks.
3. (Optional) Do either of the following:
   - To set Automation mode for all currently selected tracks, press the Do to Sel switch or its Soft Key equivalent (they light and latch on).
   - To set Automation mode for all tracks in the session, hold Do to All (SHIFT+Do to Sel) or its Soft Key equivalent (they light and latch on).
4. Press the desired Automation mode switch in the Left Control section of the Dock.
   The Automation mode switch LEDs light to indicate automation status of the currently attentioned track, only. In the figure to the right, the currently attentioned track is in Touch mode.

Using the Automation Mode Switches and Pro Tools | Control

To select track automation mode using the Dock Mode switches and the Control app:

1. In the Control app, tap Mixer or Tracks.
2. Bank the Control app so that the desired track is shown.
   - Select multiple tracks if you want to set automation mode for more than one track.
3. On the Dock, press and hold the switch in the Left Control section for the desired track automation mode (Write, Touch, Latch, TouchLatch, Trim, Read, or Off).
4. While still holding the automation mode switch, tap the desired track on-screen (if multiple tracks are selected, tap any one of them).

The switch LEDs in the Left Control section indicate automation modes as determined by the Dock Automation Mode Buttons Follow Attentioned Channel setting.
Using the REC/A Switch

You can also set the Automation mode for the track currently assigned to the Dock channel strip using its REC/A switch.

In the following instructions, the REC/A switch is configured for its default behavior in which its primary function is record enable, and its secondary, SHIFT function is automation (A). You can swap the primary and SHIFT functions of the REC/A switch in the General tab of EuControl Settings. For more information, see General.

To select the automation mode from the fader strip using the REC/A switch:

1. Hold Surface SHIFT and press REC/A.
   The track is assigned to the next automation mode. On-screen in the Control app, the Fader button in the lower left corner temporarily displays a tile similar to Tracks view showing the currently assigned automation mode. This is useful when the selected track is banked out of view in the Control app.

2. While still holding SHIFT, press REC/A again. Each press cycles through the following automation modes (as available in the currently focused DAW):
   - read
   - write
   - touch
   - latch
   - touch/latch
   - off

3. To change the automation mode on all selected tracks, press Do to Sel, then press SHIFT+REC/A.

4. To change the automation mode on all tracks, press Do to All (SHIFT+Do to Sel), then press REC/A.

Using the Advanced Automation Switches

The Dock provides dedicated switches for many advanced automation features in its Left Control section. These include Preview, Punch Preview, Suspend Preview, Capture, Punch Capture, Auto Match, and Write to... commands (All/Sel, Start, End, Punch, and Next).

These switch functions can be accessed by engaging the ALT switch.

Use these switches as you would their corresponding commands or keyboard shortcuts in Pro Tools.
Shortcuts to Display Automation Playlists

The following shortcuts let you quickly display the breakpoint automation playlist for a control by clicking it in combination with modifier keys on your computer keyboard.

Waveform View

To show the waveform for a track in the Edit window:

- Hold Control + Command (Mac) or Control + Start (Windows) and press the channel Sel switch.

Track Volume View

To show volume automation for a track in the Edit window:

- Hold Command + Control (Mac) or Control + Start (Windows) and touch the track fader.

Pan, Send Level, Send Pan, and Other Views

To display other breakpoint automation data you must first select and display that parameter in the Control app. For example, for track pan first tap a track Pan control in Tracks view, then hold Command + Control (Mac) or Control + Start (Windows) and tap the displayed track pan slider.

Plug-In Automation

Plug-in parameters can be enabled for automation from the Dock and the Control app.

💡 Pro Tools provides a preference setting for newly inserted plug-ins to default to all parameters enabled for automation. Go to Pro Tools > Preferences > Mixing, and under Automation, select Plug-In Controls Default to Auto-Enabled.

Enabling All Plug-in Parameters for Automation

To enable all plug-in controls for automation:

1. In the Control app, navigate to Channel view and tap Inserts.
2. Make sure the desired Inserts slot is displayed in a Function view slot.
3. Hold Control + Command + Option (Mac) or Control + Start + Alt (Windows) and tap the on-screen In switch for the plug-in for which you want to enable automation.

Enabling an Individual Plug-In Parameter for Automation

To enable automation for a plug-in parameter:

1. Display the desired plug-in parameters in the Control app (select a track, tap to display Channel view, then use the Function scroller to select the desired plug-in).
2. If necessary, tap to select a block of parameters in the center of the Function view until the desired parameter is displayed.
3. Hold Control + Command + Option (Mac) or Control + Start + Alt (Windows) and do one of the following:
   - For a continuous plug-in parameter such as a level control, touch the encoder for the desired parameter.
   - For a switch-type parameter such as an In/Out switch, tap the on-screen In switch for the desired parameter.
Surround Panning

Channel view in the Control app lets you access the surround panner. The Soft Knobs on the Dock map to the currently displayed pan parameters.

To pan in surround:
1. Select a track assigned to a multichannel output path.
2. In Channel view, tap the Pan function block.
3. Drag the green pan dot to pan, or use the sliders on either side of the panner. Tap a speaker icon to jump the pan dot to that location.
   - When the current track is in any automation write mode, the pan dot turns red. When automation is off, it turns yellow.
4. Use the sliders (or knobs on the Dock or S3) to adjust other pan settings such as Divergence and Center percentage, as available.

To access other parameters:
- Tap the Tiles button in the lower left corner.
  - Blocks of additional parameters are displayed; tap a block to select its set of parameters, such as Right Front.

To expand the surround panner:
1. Tap the Expand icon in the lower right corner.
   - The surround panner fills the screen, and the sliders are hidden. The Collapse icon appears below the panner.
2. To return to panner and sliders view, tap the Collapse icon.
Pan Knob Mapping
(Requires Pro Tools 12.7.1 or higher)

When panning in surround:
  • Rear position is available from the same knob as Front (see **L/R Rear via L/R Front + Sel**).
  • You can link the Front and Rear positions (see **Link F/R**).

L/R Rear via L/R Front + Sel

When the L or R Front parameter is mapped to a knob, press that knob’s **Sel** switch to reassign the knob to the corresponding channel’s Rear parameter. For example, when L Front is displayed on an encoder pressing that encoder’s **Sel** switch maps L Rear to that encoder. Press the lit **Sel** switch again (it becomes unlit) to return the encoder to L Front.

Link F/R

You can link the Front and Rear pan positions.
  • When linked, Rear position follows Front position; if you pan that channel front-to-back while linked, it pans vertically. Automation is written to both front and rear L and R knobs.
  • When unlinked, panning the same channel front-to-back will follow the trajectory between the current front position (left-to-right) and the current rear position (left-to-right).

To link Front and Rear:
1. Attention a mono or stereo track assigned to a multichannel output, and make sure Pan is assigned to an encoder for the mentioned track. If you are using the Control app, tap to go to Channel View and then select Pan from the Function selector.

2. Press the **In** switch next to the encoder assigned to Front or Rear (if the track is mono) or L (or R) Front or Rear if stereo. When linked (**In** switch lit), adjusting the F/R (front/rear) parameter pans the channel front-to-back vertically. Any offset between front and rear is ignored.
Monitoring

The Monitoring view in the Control app let you assign and manage monitor controls. The Monitoring view supports any hardware or software application with a EUCON Monitor, such as Pro Tools | MTRX, Avid XMON, Studio Monitor Pro 2, as well as Nuendo, Cubase, and Pyramix. Main (level), and Cut (mute) are also supported in Pro Tools without MTRX or XMON when you Enable EUCON Monitor (requires Pro Tools 18.7 or higher).

💡 Monitoring view is not available in the Control app when used simultaneously with an S6.

For more information, see the Pro Tools Control Guide.pdf.

Talkback via Footswitch

On supported controllers (such as S3, Dock, and Artist Mix), you can designate a footswitch to control Talkback in the Preferences tab of EuControl Settings. Talkback must be provided by the hardware or software monitor controller such as MTRX or XMON.

A normally Open, momentary Footswitch should be used for Talkback. (Latching footswitches do not support momentary actions.) For latching behavior, tap the footswitch quickly.
Enable EUCON Monitor
(Pro Tools Only)

Pro Tools lets you designate a Master Fader to act as a Monitor Path that can be controlled from EUCON control surfaces. Designation of a Master Fader as a EUCON Monitor path is stored in the Pro Tools session, letting it persist when a session is moved from a system with an S6 to one with a Dock, or similar.

💡 This feature was previously available in Pro Tools 2018.7.

To enable a Master Fader for EUCON Monitoring:

1. Ensure that Enable EUCON is selected in Setup > Peripherals > Ethernet Controllers.
2. Create a Master Fader track and assign it to any path being used for monitoring (can be your main Monitor Path, or other).
3. Right-click the name of the Master Fader and select EUCON Monitor.

The **Control Room/Monitor** knob on your EUCON control surface controls that Master Fader track for monitoring.

For example, on the Dock with a Master Fader assigned to EUCON Monitor:

- Rotating the **Control Room/Monitor** knob raises and lowers the Master Fader level.
- Pressing the knob sets Master Fader level to –INF (effectively Muting or “cutting” the monitor level). Press again to return to the previous level.
Soft Keys

When using Pro Tools | Dock with Pro Tools and other selected DAWs, an Appset is installed providing default functionality for Dock surface controls. You can customize switches, the touchstrips, and the commands in the Soft Keys view of the Control app using the Soft Key Editor in EuControl software.

For a searchable listing of all EUCON-ized Pro Tools commands, see the Pro Tools EUCON Guide.pdf.

Viewing Soft Key Assignments in the Soft Key Editor

To view assignments in the Soft Key Editor:

1. Launch Pro Tools and confirm that EuControl is connected to the Dock and Control app, indicated by a lit EuControl icon in the Menu Bar (Mac) or the System Tray (Windows).

2. On the Dock, press the Save and Cancel switches simultaneously (identified by the Show Me icon between the two switches at the bottom of the Right Control section). The 12 currently assigned primary Soft Keys are shown on-screen.

3. To view the second page of switch assignments, click the Page selector and choose Page 2 from the pop-up menu.

4. To access assignments for the other sections of switches on the Dock and/or the Control app, click the Section selector and choose one of the following:

   - **Surface** Lets you customize assignments for the twelve Dock switches in the section Soft Keys.
   - **Touchscreen** In addition to the 12 Soft Keys on the Dock, the Control app provides a dedicated Soft Keys view with 24 Soft Key assignments per page. These Soft Keys are identical to those developed for the Artist Control. For important information, see Touchscreen Soft Keys.
   - **Dock Left Edit** Lets you customize assignments for switches in the section Left Control.
   - **Dock Transport** Lets you customize assignments for switches in the section Transport.
   - **Dock Right Edit** Lets you customize assignments for switches in the section Right Control and Vertical Touchstrip.
   - **Dock Horz Touchstrip** Lets you customize assignments for the horizontal touchstrip in the section Right Control and Vertical Touchstrip.
Dock Vert Touchstrip  Lets you customize assignments for the touchstrip in the section Wheel and Horizontal Touchstrip.

💡 Other options in the Section selector apply to other Artist Series media controllers.

To view switches assigned to the Shift layer (functions accessed by pressing either of the Dock SHIFT switches plus the relevant switch), click to enable the Shift checkbox next to the Section selector.

💡 The Shift checkbox is not available for the section Dock Left Edit, since this section provides the dedicated ALT switch for its secondary functions.

**Touchscreen Soft Keys**

Selecting Touchscreen from the Section selector lets you customize what is shown in the Soft Keys view of the Control app.

When using an Artist Control and the Control app simultaneously, the Touchscreen Soft Keys are shared between the two units but should only be executed from one or the other.
**Touchstrip Soft Key Assignments**

Each of the two Touchstrips is capable of four single Soft Key commands (one per zone 1, 2, 3, and 4) or one Wheel mode, per layer. There are two layers for which each can be programmed: Normal and **SHIFT**. You can program one layer to be a single wheel mode and the other layer to be four discrete Soft Keys via the four zones. Alternatively, both layers can be assigned to two different wheel modes, or up to eight different soft keys.

The horizontal touchstrip automatically duplicates the selected Wheel mode, with the exception of Jog. When Jog is enabled for the wheel, the touchstrip is automatically placed in Shuttle mode. Any single tap Soft Key commands are still observed.

The vertical touchstrip can dynamically be assigned any Wheel mode by tapping and holding the vertical touchstrip, then pressing the desired Wheel mode button. Any single tap soft key commands are still observed.

**Load and Save As for Soft Keys**

The Soft Keys tab of EuControl Settings provides **Load** and **Save As** controls. Use these to save and load your custom appsets.

![EuControl Settings Soft Keys Tab](image)

*Load, Save, and Save As in the Soft Keys tab of EuControl Settings*

Note that when saving edited appsets using the (previously available) **Save** button, EuControl automatically names the saved appset to ensure it is compatible with that application. This ensures EuControl will automatically load the correct appset for the currently focused application. When using **Save As**, the name of the focused application must be included in the file name of the appset. For example, saving a Pro Tools 2018.1 appset on Windows as “Pro Tools.xmls” is a compatible file name, while “myappset.xmls” is not compatible.

To load a saved appset file, press **Load**. All compatible appset files are available for loading.
Using the Soft Key Editor

The Soft Key Editor lets you reassign a switch from its default Soft Key assignment (if applicable), add a new command to an unassigned switch, revert (undo) all recent assignment, and restore to factory default assignments. You can also add a key command to a switch to invoke a keyboard shortcut. The following instructions are specific to S3, but the basic steps apply to any unit.

To reassign a Soft Key for Pro Tools:

1. Launch Pro Tools and confirm that EuControl is connected to the Dock, indicated by a lit EuControl icon in the Menu Bar (Mac) or the System Tray (Windows).
3. Click the Section selector and choose the section of switches containing the switch you want to reassign.
4. On-screen double-click the switch you want to reassign. The Soft Key Command Editor window opens, showing the switch’s current assignment.

5. To reassign the currently selected switch, click a different command. For example, click Off in the third (right-most) list in the Details area. You can also click to make a new selection in the first (left-most) or middle Details list (such as File Menu, Edit Menu, and so on) to access other choices, as available.

6. Close the Soft Key Command Editor and return to the EuControl Settings window.
7. If desired, click the Save button in the Soft Keys tab to save the assignments. The next time you launch EuControl, your custom assignments are recalled.

💡 If you do not save assignments, EuControl software retains your assignments until you Quit (Mac) or Exit (Windows) the EuControl application. EuControl then recalls the default Appset the next time you launch EuControl.
To add a new assignment:

1. Launch Pro Tools and confirm the EuControl is connected to the Dock, indicated by a lit EuControl icon in the Menu Bar (Mac) or the System Tray (Windows).

2. Press **Show Me**.

3. Click the Section selector and choose the section of switches containing the switch you want to assign.

4. On-screen, double-click the switch you want to assign. The Soft Key Command Editor window opens.

5. In the Command area, click **Add** and choose EUCON.

   ![Adding a new EUCON command](image)

   After you add a EUCON command, choices appear in the Details area.

   ![The Details area showing commands](image)

6. Click an item in the left-most list (level 1) within the Details area to reveal associated commands in the middle column.

   ![An item selected in Level 1 (the first column) of the Details area](image)

7. Click a command to assign a command, or click an item with an arrow to reveal more commands in the third column and assign as necessary.

8. Close the Soft Key Command Editor and return to the EuControl Settings window.

9. If desired, click the **Save** button in the Soft Keys tab to save the assignments.

**To revert (undo) all assignments since the last time you saved changes:**

- Click the Revert button in the Soft Keys tab.
To restore assignments to their factory defaults:

- Click the Restore button in the Soft Keys tab.

**Adding a Custom Key Command**

You can invoke a keyboard shortcut that has no predefined function in EuControl using the Soft Key Editor. The following workflow shows how to assign the Pro Tools shortcut for halving the length of an Edit selection (Command + Control + Option + Shift + L on Mac, and Ctrl + Alt + Start + Shift + L on Windows) to a switch on the S3. The basic steps also apply to the Dock and other Artist Series media controllers.

💡 You can use the Pro Tools Shortcut Guide to find the relevant Pro Tools shortcuts for your operating system.

To assign a custom key command:

1. Launch Pro Tools and confirm EuControl is connected to the S3, indicated by a lit EuControl icon in the Menu Bar (Mac) or the System Tray (Windows).
2. Press the Show Me switch on S3 (or on the Dock, press Save + Cancel simultaneously).
3. Click the Section selector and choose the section of switches containing the switch you want to assign.
4. On-screen, double-click the switch you want to assign. The Soft Key Command Editor window opens.
5. In the Soft Key Editor, do the following:
   - If the switch already has an assignment, select the assignment in the Command list then press Delete.
   - Click Add and choose Key.
6. In the Details area, select Control, Shift, Alt/Opt, and Win/Cmd, then enter “L” in the field below.

💡 To insert special keyboard characters in the field such as a Function key or an arrow key, use the Insert Special menu.

7. Close the Soft Key Command Editor and return to the EuControl Settings window. Now, pressing the assigned switch halves the length of the current Edit selection in the Pro Tools Edit window.
8. If desired, do any of the following:
   - Click in the Soft Key Label field and enter a name for the Soft Key assignment.
   - Click the Save button in the Soft Keys tab to save the assignment.
**Multiple EUCON Commands in Soft Keys**

Soft Key assignments can include multiple EUCON commands, one of which can have **Command Feedback Active** enabled.

**To add a Soft Key assignment:**
1. Navigate EuControl to the **Soft Keys** tab.
2. Click the **Section** selector and choose the section of switches containing the switch you want to assign.
3. On-screen, double-click the switch you want to assign. The Soft Key Command Editor window opens.
4. In the Command area, click **Add** and choose **EUCON**.
   After you add a EUCON command, choices appear in the Details area.
5. Click an item in the left-most list (level 1) within the Details area to reveal associated commands in the middle column.
6. Click a command to assign it, or click an item with an arrow to reveal more commands in the third column and assign as necessary.
7. Repeat the previous steps to add additional EUCON commands to the Soft Key assignment.

**Command Feedback Active**

When Soft Key assignments include multiple EUCON commands, you can specify which command should be indicated on the Soft Key and/or controller LED by enabling the **Command Feedback Active** option for that command. When enabled, your controller displays status indication of the corresponding EUCON command. This option, located in the Details area of the Soft Key Editor, can only be enabled for a single EUCON command in each Soft Key definition.

**EuControl Surface Commands**

In the EuControl Soft Key Editor (EuControl Settings > Soft Keys) the command type previously labeled MC/Internal has been renamed **Surface**. Available commands include numerous monitoring commands, Layout recall, control surface Options (such as brightness and other Preference settings), General commands such as Suspend All Faders, and the previously available Internal commands.
EuControl Software

EuControl is launched automatically upon starting your computer and runs in the background. EuControl is responsible for finding, linking, and communicating with all Avid media controllers on the network.

Accessing EuControl Settings

To open the EuControl Settings window, do one of the following:

- On Mac, click the EuControl icon on the taskbar and select EuControl Settings.
- On Windows, double-click the EuControl icon in the system tray and select EuControl Settings. If you don’t see the EuControl icon, it could be automatically hidden by Windows. Click on the small white arrow to show hidden icons, then double-click the EuControl icon.

Only one instance of EuControl can run on a workstation. However, multiple workstations on a single network can each run EuControl. Each EuControl-equipped workstation can connect one Dock on the network.

In this chapter, the tabs in the EuControl software are discussed in the order (left to right) as they appear at the top of the EuControl Settings dialog.
Surfaces

The Surfaces tab shows all EUCON controllers on your network and those connected to your instance of EuControl.

**All Surfaces**

All Surfaces shows all Avid media controllers on the network. A device shown in light gray is already connected either to your own or another instance of EuControl running on a different workstation. In both cases, it is not selectable.

**My Surfaces**

My Surfaces shows the media controllers connected to your instance of EuControl.

The top-to-bottom order corresponds to the left-to-right order of the surfaces, respectively. The leftmost surface is assigned to fader strip 1. Use the + and – buttons to reorder the list.

Each media controller can be renamed by double-clicking the existing name and typing a new name.

💡 *If you changed the name of the S3 in VENUE software, that name will appear in the My Surfaces list. Likewise, if you changed the name in the My Surfaces list, it will appear as such in VENUE software.*

**Add**

Click Add to add the selected All Surfaces entry to My Surfaces. This connects the selected Avid media controller to your instance of EuControl. You can also click and drag an Avid media controller from All Surfaces to My Surfaces.

Add is disabled if all media controllers in All Surfaces are connected to any instance of EuControl.

**Remove**

Click Remove to remove the selected surface from My Surfaces and make it available to other instances of EuControl. Remove is disabled if no surface is selected.
**Automatically Add**

The **Automatically Add** menu has two settings that control what happens to stored Surfaces between shutdown and startup.

**All Surfaces (Default)**

This setting is best used when you are the only person running EuControl in your home or studio. It provides an easy plug-and-play experience by automatically adding your All Surfaces list to your My Surfaces list so you never have to manually edit the My Surfaces list.

**My Surfaces Only**

This setting is useful in facilities where other EuControl users are on your network. When EuControl starts, only the surfaces from your My Surfaces list are added. Because a surface can only be claimed by one user at a time, this avoids claiming another user’s surfaces.

**Update Firmware**

Each time a new version of EuControl is installed, it checks each media controller in your system to determine if any firmware updates are required. The firmware is embedded in EuControl so an Internet connection is not required.

Select each media controller in the My Surfaces list. Click **Update Firmware** to update their firmware. If a dialog displays a message that the firmware is up to date, no further action is necessary.

Follow the instructions in the EuControl dialog box.

* The media controllers must be plugged into a working power source.
* Do not power off any media controllers during the update or attempt to interrupt the update.
* The status for each media controller being updated is displayed on that device as well as in the EuControl dialog.

**Show Info**

Select a media controller and click **Show Info** to display the name of the unit, and hardware and software information.
**Workstations**

A media controller can control applications running on a second computer, referred to in this guide as a *workstation*. The Workstations tab establishes the list of workstations that the Workstation switch cycles through. Any workstation running EuControl software can be in this list.

---

**Enable External Workstations**

Enables communication with other workstations (other than the one currently running EuControl). Before enabling an additional workstation, make sure you have installed EuControl or EUCON Workstation software on your secondary workstation and configured your systems as explained in *Connecting a Second Workstation*.

When the Enable External Workstation setting is enabled, the Workstation tab also provides the Redirect Keyboard and Mouse Control to Attached External Workstation setting.

**All Workstations**

All Workstations lists all EUCON-enabled workstations on the network. If the workstation is already in the My Workstations list, it is shown in gray and cannot be selected.

**My Workstations**

My Workstations lists the workstations that can be attached to by pressing the Workstation switch *(Surface SHIFT + Application/Workstation)*.

It is possible to put a workstation in the My Workstations list that is already attached to another instance of EuControl running on another computer. It cannot be attached here until it is unattached from the other instance of EuControl. This allows multiple users to share workstations without having to frequently edit their My Workstation list.

**Add**

Click Add to add the selected workstation from the All Workstations list to the My Workstations list. If the workstation is already in the My Workstations list, it is grayed out and cannot be selected.
**Remove**
Click Remove to remove the selected workstation from the My Workstations list.

**Attach/Detach**
Use the Attach/Detach buttons to switch between Workstations when using the Control app by itself, or any Artist Series media controller that does not provide an Application/Workstation switch.

Select a workstation in the My Workstations list and click Attach. A check mark appears in the Attach column next to that workstation. This workstation is now communicating with the media controller(s) connected to your instance of EuControl.

If the selected workstation is already attached, the button displays Detach. Click it to detach the workstation.

**Redirect Keyboard and Mouse Control to Attached External Workstation**
Your computer keyboard and mouse can control a second external workstation, if desired. Select this option to redirect keyboard and mouse control to the attached workstation. Note that the keyboard and mouse will no longer control your primary computer.

You can manually toggle control back and forth between your primary workstation and the attached external workstation by pressing Control+Option+Command+Esc (Mac), or Control+Alt+Win+Esc (Windows), or by pressing the App/Workstation switch on the Dock, S3, or other supported controller.

The Redirect Keyboard and Mouse Control to Attached External Workstation option must be checked before adding the workstation to the My Workstations list. If it is toggled ON after adding the workstation it will have no affect. Only workstations added with the option checked will respond.
**General**

The General tab lets you control how the Control app and the media application work together.

**Attention Most Recently Selected Track (Legacy)**

When using a DAW that does not directly support the new Attention Most Recently Clicked DAW Area features, the previously available Attention most recently selected track setting remains available. When using a DAW that does directly support these new features, Attention most recently selected track is not available.

**Attention on Select Button Press**

See [Surface Attention Follows DAW](#).

**Attention Most Recently Clicked DAW Area**

See [Surface Attention Follows DAW](#).

**Auto-bank to Selected Track**

When selected, the S3 and Artist Series media controllers (including the Control app) bank to tracks when the tracks are selected on-screen. The controller will auto-bank such that the selected track appears on the leftmost fader of the surface as long as the selected track is not currently visible on the surface.

**Select by Touch**

When this command is enabled, touching a fader on a hardware controller, or in the Mixer view of the Control app, selects/attentions the track.

**Display Track Numbers on Surface**

When this is selected, the controller and/or Control app shows track numbers as assigned by the current workstation (if supported) in the channel displays.
**Suspend All Faders**

Suspend All Faders lets you disengage faders from following automation. Faders still control on-screen levels, but will not move in response to automation or on-screen adjustment of their current parameter. Unlike the Faders Off Soft Key (EUCON > Global > Faders Off) faders stay at their current position when suspended.

Suspend All Faders is available as a Soft Key. In the Soft Key Editor, add a new Surface command, then choose Options > General > Suspend All Faders.

**Rec/Auto Switch Press**

The Rec/Auto switch press changes automation modes setting toggles the default function of the Rec/A switch (on S3 and Dock) and the Rec/Auto switch (Artist Mix and Artist Control). This feature does not apply to Pro Tools | Control.

- When enabled, pressing the Rec/Auto switch changes the track automation mode. SHIFT+Rec/A enables track record.
- When disabled, the Rec/A switch operates in its default configuration.

**Dock Automation Mode Buttons Follow Attentioned Channel**

(Pro Tools | Dock Only)

This setting lets you optimize how the Automation mode switches in the Left Control section select and indicate Automation modes. By default, this setting is off (not enabled).

- When not enabled (its default setting), you can set track Automation mode for the currently attentioned track by holding one of the dedicated Automation mode switches on the Dock, then pressing the Sel switch to the left of the Dock fader. The Automation mode switch LEDs light to indicate all automation modes currently enabled on any tracks in the session. When applying an automation mode change to a selection of tracks or all tracks, simply press the Do to Sel (Selected) or Do to All switches, then press the desired Automation mode switch. There is no need to press the Sel switch.
- When enabled, you can set track Automation mode for the currently attentioned track directly using the mode switches in the Left Control section (you do not need to hold an Automation mode switch and press Sel). The Automation mode switch LEDs light to indicate automation status of the currently attentioned track, only.

💡 *At the time of this writing, this feature is fully supported in Pro Tools, only.*

**Reverse Inserts and Dynamics on S3 and Mix**

You can reverse the order of plug-in parameters by enabling these options in the General tab of EuControl Settings. These settings are useful when using certain manufacturer’s plug-ins that spill parameters differently than others.

- When not enabled (default setting), parameters are displayed across S3 (upper knobs) and Mix in their default order.
- When either setting is enabled, parameters are spilled in reverse order.

**Solo Mode**

These settings let you configure the following Solo modes as (if) available in the current workstation (see the documentation for your specific workstation for details on Solo modes):

- Solo-in-Place
- After-Fader Listen (AFL)
- Pre-Fader Listen (PFL)

**Wheel Sensitivity**

(Pro Tools | Dock, Artist Control, and Artist Transport Only)

The sensitivity of the Jog Wheel and Shuttle Ring can be precisely adjusted using the Wheel Sensitivity sliders. The top two sliders pertain to the Pro Tools | Dock and Artist Transport, the bottom is the Jog Wheel for the Artist Control.

The center position is the default for each control. Click and drag a slider to move it right for faster response or left for a slower, more controlled movement. Click the Reset button to restore the center position.
The name of the currently focused application is shown above the sliders (the application that will be affected by adjusting Wheel Sensitivity). If the controls have been locked to a specific application, the display will list it and identify it as the application being adjusted. For more information on locking, see Lock to Application.

**Global or Application Specific**
- Click to enable the Global option to maintain a single set of your Wheel Sensitivity settings to be available regardless of the current application.
- Click to enable the Application Specific option to be able to have unique Wheel Sensitivity settings in each application you use. To store settings, switch to your other application, open EuControl Settings > General, and adjust the Wheel Sensitivity sliders for that environment.

**Workstation Tracks Knob Set Changes**
This command lets supported workstations (such as Nuendo) follow selection of knob sets on S3 and similar Artist Series media controllers. This feature does not apply to the Pro Tools | Control app.

**Open/Close Window on Workstation When Editing**
In previous versions of EuControl, the Open plug-ins on workstation when editing setting (in EuControl Settings > Preferences) let supported workstations open plug-in windows on-screen when a plug-in was selected for editing on S3 and similar Artist Series media controllers (all except Pro Tools | Control). Similarly, the Close plug-ins on workstation when exiting setting would, when enabled, close the plug-in window when the controller was focused on a different element.

Beginning in EuControl 19.5 these settings have been expanded, renamed, and moved to a different location in the General tab. In addition, these settings also now apply to actions in the Control app.

**Open Windows on Workstation When Editing** provides a drop-down menu with the following choices:
- Open Plug-Ins Only
- Open Plug-Ins and Pan
- Open Plug-Ins and Sends
- Open Plug-Ins, Pan, and Sends

When Open Windows on Workstation When Editing is enabled for plug-ins, pan and/or sends:
- **Plug-Ins** Pressing a knob to access a function (such as Inserts > EQ3, or EQ if that type of insert exists on the currently selected track) opens the corresponding window on-screen and closes any previously opened window of the same types.
- To open a plug-in window from the top-level function view, press the Sel switch directly below the displayed plug-in name.
- **Pan and Sends** Touch a knob assigned to Pan or Sends.

In the Control app, touching the Pan, EQ, or Dyn block in the function scroller opens the corresponding window on-screen. For sends, touch a Send level slider (or associated knob on the Dock, S3, or other hardware controller, if any).

⚠️ *If using Pro Tools 2018.12 or earlier, consider disabling these settings to avoid possible undesirable behaviors.*

**Close Windows on Workstation When Exiting** When this setting is enabled, attentioning any other track “exits” the current function and closes the corresponding window type(s) selected in Open Windows on Workstation When Editing (unless the same function exists on the newly attentioned track, in which case the window remains open but is focused on the newly attentioned track).


### Additional Information for Open/Close Windows Settings

#### Tip for Managing Pro Tools Windows

If you want certain plug-in, output/pan, or sends windows to remain visible at all times, use the Target feature in Pro Tools.

For windows such as essential metering plug-ins, turn the Target off to ensure it remains visible. Click on the Target to toggle it on/off, or hold Shift on the computer keyboard while clicking to open a plug-in window to open it with the Target off. For example, using the Control app hold down Shift on the computer keyboard (or the Soft Key for computer Shift) while tapping an Insert. On S3, hold down **Multi-Select/Shift** (or Shift on the computer keyboard. The window opens with the Target off.

When the Target icon is unlit (grey), that window remains on-screen until you explicitly close that window.

**Target, unlit/off**

When the Target icon is lit red in a plug-in, output/pan or send window, that window is replaced when another similar element is attentioned (such as a plug-in on a different track). By default, windows open with the Target on.

**Target, lit/on**

---

<table>
<thead>
<tr>
<th>Open Windows Setting</th>
<th>Trigger</th>
<th>Additional Information</th>
</tr>
</thead>
</table>
| **Plug-Ins**         | • S3/Dock/Artist: Pressing a knob to access a plug-in's controls. Or pressing the **Sel** switch below an insert name in Inserts view (press **Sel** again to close the plug-in window)  
• Control app: Tapping the Dyn or EQ function blocks in Channel view (when a compatible plug-in exists on the currently attentioned track), or tapping to select a plug-in block in Inserts view | • Switches (such as **In** and **Sel**) do not trigger a windowing action, except for the **Sel** switch below an insert name in Inserts view.  
• Hold Shift (on the computer keyboard or equivalent soft key) while triggering to open the plug-in window with the Target off. |
| **Pan**              | • Touch a pan knob  
• Touch a pan puck in the Control app Channel view | Hold Shift (on the computer keyboard) while triggering to open the window with the Target off. |
| **Sends**            | Touch a Send knob | • Switched controls (**In**, **Sel**) on Send encoders do not trigger a Windowing action.  
• Hold Shift (on the computer keyboard or equivalent soft key) while triggering to open the window with the Target off. |
Preferences tab

OLED Dim Time
This setting sets the amount of idle time before displays on the supported units are dimmed.

Footswitch
(Pro Tools | Dock, Pro Tools | S3, Artist Mix and Artist Control Only)
You can connect a footswitch for hands-free punch in/out, and Talkback (with a supported hardware controller such as the Dock). Connect a footswitch to the 1/4-inch footswitch input on the back panel.

To configure the Footswitch in EuControl:
- In the Footswitch section of the Preferences tab, click to select the desired assignment:
  - Talkback On supported controllers (such as S3, Dock, and Artist Mix), you can designate a footswitch to control Monitoring Talkback. A normally Open, momentary Footswitch should be used for Talkback. Pressing and holding enables Talkback, releasing disables. For latching behavior, tap the footswitch quickly.
  - Record | Record When the application is rolling, pressing the footswitch once punches into recording on record enabled tracks. Pressing the footswitch again takes the track(s) out of record but does not stop the transport.
  - Record | Play Pressing the footswitch once punches into recording on record enabled tracks. Pressing the footswitch again stops the record pass (your DAW may or may not automatically take the track out of record on stop; see the documentation for your application).
  - Status Shows whether the footswitch state is currently on or off.

In Pro Tools, you must first enable a punch recording mode (QuickPunch, Track Punch, or Destructive Punch).

The S3 also lets you assign the footswitch to engage Talkback. For more information, see the Pro Tools | S3 Guide.pdf.
S3 VCA Spill
(Pro Tools | S3 Only)

The options in the S3 VCA Spill section determine VCA Spill behavior on systems that include a Pro Tools | S3.

Single-Master Mode (S3 + Dock)

These choices determine whether a spilled VCA master is assigned to the Dock channel strip or to an S3 channel strip.

Assign VCA Master to Dock  When selected, spilling a VCA from S3 in Single-Master mode assigns the spilled VCA master to the Dock channel strip.

Assign VCA Master to S3  When selected, spilling a VCA from S3 in Single-Master mode assigns the spilled VCA master to strip 16 on the S3.

Multi-Master Mode

These options determine VCA Spill behavior in Multi-Master Mode, as follows:

Assign VCA Masters to Channel Strips 9–16  When selected, up to eight VCA Masters are assigned to S3 channel strips 9–16. Members of the selected VCA Master are spilled to channel strips 1–8 in banks of eight channels.

Assign VCA Masters to Channel Strips 13–16  When selected, up to four VCA Masters are assigned to S3 channel strips 13–16. Members of the selected VCA Master are spilled to channel strips 1–12 in banks of 12 channels.

VCA Spill Overrides Layout

By default, if you spill a VCA while a Layout is recalled, the spilled VCA member tracks replace all tracks from the Layout. Unspilling the VCA returns fader strips to their previous assignments from the Layout. You can defeat this behavior in the Preferences tab of EuControl Settings. When the VCA Spill Overrides Layout setting is disabled, member tracks of a spilled VCA only spill to any <auto assigned> strips in the current Layout. If the current Layout has explicitly assigned tracks to all 16 S3 fader strips, no member tracks will be visible.

Auto Spill VCA from Control App Attention

When enabled, attentioning a VCA in the Pro Tools | Control app spills that VCA across S3, Artist Mix, or Artist Control. When a Dock is present, spill and Master follow current S3 VCA Spill settings.

Surface Brightness Control

The settings in this section let you control brightness for Artist Control LCD screens and for the Pro Tools | Dock switch LEDs.

Artist Control LCD Screen  Adjusts the brightness of the LCD screen on Artist Control (only). To increase brightness, adjust the slider to the right. To decrease, adjust to the left.

Pro Tools | Dock  Adjusts the brightness of the switch LEDs on Pro Tools | Dock (only). To increase brightness, adjust the slider to the right. To decrease, adjust to the left. Setting the slider to the far left turns all switch LEDs off.

Miscellaneous

Shift + Fader Sets Level to 0dB  When enabled, holding SHIFT and touching a fader sets the fader to 0dB. Surface SHIFT-lock does not apply (Surface SHIFT must be pressed).

Momentary Fader Value Display

You can optimize fader display of track name and values by configuring the Show Timed Fader Values and Fader Value Timeout settings in the Preferences tab of EuControl Settings.

Show Timed Fader Values  When enabled, values temporarily replace track name on fader displays when the fader is touched or adjusted. The length of time values are displayed is determined by the Fader Value Timeout setting.

Fader Value Timeout  The Fader Value Timeout setting lets you customize the length of time values are displayed (between 0 and 5 seconds).
Assign

The Assign tab manages how tracks are assigned to S3 channel strips, or to the Dock channel strip, and to Layouts. By default, tracks are automatically assigned on S3 in banks of 16.

Display Application’s Track Numbers

Enabling this option lets EuControl display track numbers as assigned by the currently selected (in focus) application (if that application supports track numbers).

Clear All Assignments

Clears all currently displayed assignments.

Lock to Application

This feature does not apply to S3.

This feature lets the transport and monitor controls, and/or the entire surface, stay locked to the application listed at the top-left of the dialog, even when that application is not focused. The locked-to application also is the only application that will be affected by adjusting the EuControl Wheel Sensitivity settings.

Entire Surface Select this checkbox to lock the entire surface, including those of all linked Artist media controllers, to the listed application.

Transport Select this checkbox to lock only the transport controls to the listed application. All transport controls, including jog/shuttle wheels, are locked when selected.

Monitor and Control Room Locks the Monitor and Control Room controls to the listed application.
**Layouts**
*(Pro Tools | S3, Artist Mix, and Artist Control Only)*

Use the **Layouts** tab to store and recall custom fader layouts. For example, you can use the **Assign** tab to assign tracks to specific S3 channel strips. You can then save those assignments as part of a fader layout on the **Layouts** tab, which you can then recall using the Bank A–F switches. For more information, see the *Pro Tools | S3 Guide.pdf*.

![Layouts tab](image)

*Layouts are created and temporarily stored in EuControl as long as the current session or project is open. To be able to recall your layouts, be sure to save your session or project in your workstation application.*

**Soft Keys**

This tab controls assignments and programming for the switches and touchstrips on Pro Tools | Dock and other Artist Series media controllers. See **Soft Keys** for more information.

**Restart EUCON Applications**

If you are having trouble connecting your surface to your DAW, use the Restart EUCON Applications command.

**To restart all EUCON applications (including EuControl software):**

- On Mac, click the EuControl icon on the taskbar and select **Restart EUCON Applications**, then click **Yes**.
- On Windows, click the EuControl icon in the Task or System tray (Windows) and select **Restart EUCON Applications**, then click **Yes**. Unused icons will be shown in the Hidden icons view.

All EUCON applications are restarted, including EuControl.
# Appendix A: Specifications

All specifications subject to change.

**Module:** Pro Tools Dock

## Mechanical

### Pro Tools | Dock Mechanical Specifications

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions (L x W x D)</td>
<td>14.1 x 13.87 x 5.4 inches (height at back) 359 x 352 x 138 mm</td>
</tr>
<tr>
<td>Weight</td>
<td>4.17 lbs 1.89 kg</td>
</tr>
<tr>
<td>Power Requirements</td>
<td>2.5 A</td>
</tr>
<tr>
<td>Ethernet Port</td>
<td>1000-BaseT (Gigabit) Ethernet RJ-45</td>
</tr>
</tbody>
</table>

## Environmental

### Pro Tools | Dock Environmental Specifications

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specification</th>
<th>Limit</th>
<th>Units</th>
<th>Condition/Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage Temperature</td>
<td>–18 to +60 deg C</td>
<td>deg C</td>
<td></td>
<td>0 to +140 deg F</td>
</tr>
<tr>
<td>Operating Temperature</td>
<td>+4 to +40 deg C</td>
<td>deg C</td>
<td></td>
<td>+40 to +104 deg F</td>
</tr>
<tr>
<td>Storage humidity range</td>
<td>5 to 95</td>
<td>%</td>
<td></td>
<td>Non-condensing</td>
</tr>
<tr>
<td>Operating Humidity Range</td>
<td>20 to 80</td>
<td>%</td>
<td></td>
<td>Non-condensing</td>
</tr>
<tr>
<td>Continuous Vibration (Storage only: non-powered transportation)</td>
<td>1</td>
<td>g RMS</td>
<td>Random spectrum</td>
<td></td>
</tr>
</tbody>
</table>
Test Mode

The Pro Tools | Dock has a self-test mode that lets you test the fader, LEDs and knob touch-sensitivity. This self-test mode is similar to “Vegas Mode” on other control surfaces.

To enable Test Mode on the Dock:

1. Power the Dock off.
2. Press and hold down both Bank switches (< and >) simultaneously while powering the Dock back on.

On the Dock, all LEDs light and cycle through their color range.

- Press any switch and you will see all LEDs change to the Yellow/White range.
- Test the touch-sensitivity of the knobs. Tapping a knob will switch the LEDs to the Yellow/White color range.
- Rotate the top-left knob to change the speed of the fader cycle.
- Touching the fader will cause it to stop cycling.

Note that not every LED will light up with certain colors. For example, in the Blue test the Write, Latch, and Trim LEDs (among others) will stay unlit. In the Yellow/White test some of the LEDs will appear Yellow and others appear White.
If you are using the Dock along with an S3, you can use the Avid S3 Dock Link kit (not included) to attach them to each other. The Link kit lets you attach the Dock to the left or right of S3 to keep them stable and aligned. You can install the Link Kit at any time.

### Installing the S3 Dock Link Kit

The following sections explain each of the steps required to install the Link Kit.

- **Collecting the Required Items**
- **Getting Started**
- **Installing the Spacer Plates**
- **Attaching the Foot Bracket**
- **Installing the Link Plate**
- **Attaching the Dock to the S3**

### Collecting the Required Items

Installing the Link Kit requires the following additional items that are not included in the kit:

- #1 Phillips screwdriver.
- A padded surface large enough to be able to place the S3 face down.
- Two blocks to set the S3 on during installation. Both blocks should be at least 1-inch wide, 1-inch tall, and 8-inches long.

### Getting Started

To begin, unpack the contents of the Link Kit and then prepare the S3 for installation.

**To get started installing the Link Kit:**

1. Decide how you want to arrange your Dock and S3 (Dock to the left of S3, or to the right of S3).
2. Unpack the Avid S3 Dock Link bracket and other components, shown in the following figure.

![Figure 1. Link Plate, Spacer Plates, and Foot Bracket](image)

In the following table, numbers refer to the figure, above.

<table>
<thead>
<tr>
<th>Number</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Link Plate</td>
</tr>
<tr>
<td>2</td>
<td>Spacer Plates (2x) with adhesive backing</td>
</tr>
<tr>
<td>3</td>
<td>Foot Bracket</td>
</tr>
<tr>
<td>not shown</td>
<td>Fasteners (2x Phillips, M3 x 12mm, flat head)</td>
</tr>
</tbody>
</table>
3 Turn the S3 over and slowly set it face down on a padded surface, being careful not to let the unit drop (this could damage the encoders and faders). The following is recommended:

- When turning the S3 over, orient it so that its back panel (with ports and connectors) is closest to you. If the front (with headphone level control) is closest to you, the left and right sides will be reversed relative to when the unit is facing up.
- We strongly recommend using blocks placed at both ends of the unit when facing down, similar to the figure below, to prevent the unit from resting on its encoders and faders.

💡 Instead of blocks, you can also use the foam packing included in the original S3 package.

![Figure 2. Placing the S3 on blocks to protect the encoders and faders](image)

**Installing the Spacer Plates**

To install the S3 Spacer Plates:

1. Take one of the Spacer Plates and remove its adhesive backing.

2. Making sure the adhesive backing is oriented towards the S3, align the holes in the Spacer Plate with the two fasteners on the underside of the S3, and attach the Spacer Plate to the left or right of the S3 as shown below.

Two Spacer Plates are included so that you can attach one to both the left and right sides of S3 to simplify re-arranging the units.

![Figure 3. Spacer Plates installed on both the left and right sides](image)
**Attaching the Foot Bracket**

Next, attach the Foot Bracket to the front corner of the underside of the S3. The figures below show the Foot Bracket being installed to have the Dock to the right of the S3 (when turned right-side up for use). If you want the Dock to the left of the S3, the basic steps are the same. The Foot Bracket is reversible and can be attached to either side of the S3.

**To install the Foot Bracket:**

1. Using a #1 Phillips screwdriver, remove the two screws indicated below, as appropriate for which side you want the Dock.

![Figure 4. Removing screws from the S3](image)

2. Attach the Foot Bracket to the S3 by orienting it as shown below.
   - Place the hole in the Foot Bracket over the foot of the S3 as shown below, then align the bracket with the receiver holes for the screws you removed previously.
   - Secure the Foot Bracket to the S3 using the included M3 x 12mm fasteners.

💡 *If you have a case in which you pack your S3 for travel, or if you expect to alternate which side you want to have the Dock, you do not need to secure the Foot Bracket to the S3 with fasteners. Just keep in mind it can fall off when lifting the S3.*

![Figure 5. Attaching the Foot Bracket to S3](image)
**Installing the Link Plate**

The Link Plate is held magnetically to the underside of the S3.

**To install the Link Bracket:**

- Orient the Link Plate and align its pins with the holes in S3 as shown below (1 in Figure 6), then place it against the underside of the S3 (2 in Figure 6).

  The bracket is magnetic and requires no fasteners to attach it.

![Figure 6. Attaching the Link Plate to S3](image)

**Attaching the Dock to the S3**

With the Foot Bracket and Link Bracket attached to the S3, you are ready to turn the S3 back over and attach the Dock.

**To attach the Dock to S3:**

1. Turn the S3 over so it is once again facing up.

2. Bring the Dock next to the S3 on the side where you installed the Link Kit, and line up the front foot of the Dock with the receiving hole on the Foot Bracket.

3. Set the Dock down so its front foot rests in the Foot Bracket, and its notches are seated fully on the short pins and blocks of the Link Plate.

![Figure 7. S3 and Dock, linked](image)
Appendix C: Compliance Information

Model Name: Pro Tools | Dock  Model #: 9100-65779

Environmental Compliance

Disposal of Waste Equipment by Users in the European Union

This symbol on the product or its packaging indicates that this product must not be disposed of with other waste. Instead, it is your responsibility to dispose of your waste equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. The separate collection and recycling of your waste equipment at the time of disposal will help conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more information about where you can drop off your waste equipment for recycling, please contact your local city recycling office or the dealer from whom you purchased the product.

Proposition 65 Warning

⚠️ This product contains chemicals, including lead, known to the State of California to cause cancer and birth defects or other reproductive harm. Wash hands after handling.

Perchlorate Notice

This product may contain a lithium coin battery. The State of California requires the following disclosure statement: “Perchlorate Material – special handling may apply. See www.dtsc.ca.gov/hazardous waste/perchlorate.”

Recycling Notice
EMC (Electromagnetic Compliance)
Avid declares that this product complies with the following standards regulating emissions and immunity:

- FCC Part 15 Class B
- EN 55022 Class B
- EN 55024
- AS/NZS CISPR 22 Class B
- CISPR 22 Class B

FCC Compliance for United States
Radio and Television Interference

Communication Statement
NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try and correct the interference by one or more of the following measures:
- Reorient or locate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.
Any modifications to the unit, unless expressly approved by Avid, could void the user's authority to operate the equipment.

Australian Compliance

Canada ICES-003 Compliance
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.
Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

Korea Class B EMC Compliance
이 기기는 가정용 (B 급) 전자파적합기기로서 주 로 가정에서 사용하는 것을 목적으로 하며, 모 든 지역에서 사용할 수 있습니다.

Japan VCCI B Compliance

CE Compliance
(EMC, Safety and RoHS)

Avid is authorized to apply the CE (Conformite Europenne) mark on this compliant equipment thereby declaring conformity to EMC Directive 2004/108/EC, Low Voltage Directive 2006/95/EC and RoHS Directive 2011/65/EC.
Safety Compliance

Safety Statement: (Model #: 9100-65779)

This equipment has been tested to comply with USA, Canadian, EU and International safety certification standards: UL 60950-1 2nd edition, CAN/CSA C22.2 No. 60950-1-07; 2nd edition, EN 60950-1:2006 /A11, /A1, /A12, /A2 and IEC 60950-1:2005/A1, /A2.

Avid Technology Inc., has been authorized to apply the appropriate NRTL mark on its compliant equipment.

Power Safety Input Rating

Pro Tools | Dock: 12Vdc. 2.5A

Warning

Important Safety Instructions

1) Read these instructions.
2) Keep these instructions.
3) Heed all warnings.
4) Follow all instructions.
5) Do not use this equipment near water.
6) Clean only with dry cloth.
7) Do not block any ventilation openings. Install in accordance with the manufacturer's instructions.
8) Do not install near any heat sources such as radiators, heat registers, stoves, or other equipment (including amplifiers) that produce heat.
9) Only use attachments/accessories specified by the manufacturer.
10) Only perform the services explicitly described in the install and or user manual. For services or procedures not outlined in the install or user manual, speak with authorized service personnel.
11) Refer all servicing to qualified service personnel. Servicing is required when the equipment has been damaged in any way, such as power-supply cord or plug is damaged, liquid has been spilled or objects have fallen into the equipment, the equipment has been exposed to rain or moisture, does not operate normally, or has been dropped.
12) For products that are a Mains powered device:
   The power inlet is the main disconnect device and should remain accessible. Disconnect the power cord before servicing the unit.
   Protect power cords from being walked on or pinched particularly at plugs, convenience receptacles, and the point where they exit from the equipment.
   Unplug this equipment during lightning storms or when unused for long periods of time.

Warning! To reduce the risk of fire or electric shock, do not expose this equipment to rain or moisture.

Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug has two blades and a third grounding prong. The wide blade or the third prong are provided for your safety. If the provided plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet.
This unit may be provided with a power supply cord set suitable for 120V AC input only (for U.S.A. and Canada). For other than U.S.A. and Canada, a qualified person must provide for use with this unit, an appropriate, approved power supply cord set which is in compliance with the end use country requirements and has a minimum cross-sectional area of 1.0mm².

13) For products containing a lithium battery:

⚠️ **Warning!** Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type.

14) For products with a power switch:

It should remain accessible after installation.

15) The equipment shall be used at a maximum ambient temperature of 40° C and maximum altitude of 2000m.

16) For products with an operator-accessible fuse:

CAUTION: For continued protection against risk of fire, replace only with same type and rating of fuse.

ATTENTION: Pour ne pas compromettre la protection contre les risques d'incendie, remplacer par un fusible de même type et de même caractéristiques nominales.

17) For products that are not rack-mountable: Use only with a cart, stand, tripod, bracket, or table specified by the manufacturer, or sold with the equipment. When a cart is used, use caution when moving the cart/equipment combination to avoid injury from tip-over.

18) Rack-Mount Safety Instructions

1) Elevated Operating Ambient - If installed in a closed or multi-unit rack assembly, the operating ambient temperature of the rack environment might be greater than room ambient. Therefore, consider installing the equipment in an environment compatible with the maximum ambient temperature (Tma) specified by the manufacturer.

2) Reduced Air Flow - Installation of the equipment in a rack should be such that the amount of air flow required for safe operation of the equipment is not compromised. Stage 48 airflow is from the front of the chassis enclosure to the rear. Make allowances for cooling air to be available to the front panel surface and no restrictions at the rear.

3) Mechanical Loading - Mounting of the equipment in the rack should be such that a hazardous condition is not achieved due to uneven mechanical loading.

4) Circuit Overloading - Consideration should be given to the connection of the equipment to the supply circuit and the effect that overloading of the circuits might have on overcurrent protection and supply wiring. Appropriate consideration of equipment nameplate ratings should be used when addressing this concern.

5) Reliable Earthing - Reliable earthing of rack-mounted equipment should be maintained. Particular attention should be given to supply connections other than direct connections to the branch circuit (for example, use of power strips).